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Printer Parts and Functions

Unpacking the Printer

The box that your printer is packed in should include a printer 
software CD-ROM and the items shown in the illustration below.

Note:
❏ In some locations, the power cord comes attached to the printer.

❏ Because the shape of the AC plug varies by country, make sure that 
the plug included is the right shape for the AC outlets in your 
location.

paper support

power cord

ink cartridges

printer
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Before setting up and turning on the printer, remove all protective 
materials packaged with your printer according to the 
instructions included with the printer. Save all packaging and 
protective materials for transporting the printer in the future.
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Printer Parts and Control Panel Functions

   

sheet feeder

edge guides

output tray extension

output tray

printer cover

paper support

ink cartridge clamps

adjust lever

control panel

Print head
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    Buttons

Lights

Button Function

P
power

Turns the printer on and off.

Clears the printer's memory if pressed twice while the 
power is on.

E
load/eject

Loads or ejects paper if pressed and released within 
2 seconds.

Resumes printing if pressed and released after a paper 
out error.

R
cleaning

Moves the print head to the ink cartridge replacement 
position if pressed for 3 seconds while the B black or A 
color ink out light is flashing or on.

Returns the print head to its home position after ink 
cartridge replacement.

Performs print head cleaning if pressed for 3 seconds 
when the B black or A color ink out light is off.

Light Description

P
power

On when the printer is on.

Flashing when printer is receiving data, printing, 
replacing an ink cartridge, charging ink, or cleaning 
the print head.

S
paper out

On when the printer is out of paper. Load paper in the 
sheet feeder, then press the E load/eject button to 
resume printing.

Flashing when the paper is jammed. Take all of the 
paper out of the feeder, then reload the paper. If the 
light continues to flash, turn off the printer and gently 
pull all of the paper out of the printer.
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B
black ink 
out

On when the black ink cartridge is empty. Replace the 
black ink cartridge (T003).

Flashing when the black ink cartridge is nearly empty.

A
color ink 
out

On when the color ink cartridge is empty. Replace the 
color ink cartridge (T005).

Flashing when the color ink cartridge is nearly empty.
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Safety Instructions

Important Safety Instructions

Read all of the instructions in this section before using your 
printer. Also, be sure to follow all warnings and instructions that 
are marked on the printer.

❏ Do not block or cover the openings in the printer’s cabinet. 
Do not insert objects through the slots.

❏ Do not to spill liquid on the printer.

❏ Use only the type of power source that is indicated on the 
printer’s label.

❏ Connect all equipment to properly grounded power outlets. 
Avoid using outlets that are on the same circuit as 
photocopiers or air control systems that regularly switch on 
and off.

❏ Avoid electrical outlets that are controlled by wall switches 
or automatic timers.

❏ Keep the entire computer system away from potential sources 
of electromagnetic interference, such as loudspeakers or the 
base units of cordless telephones.

❏ Do not use a damaged or frayed power cord.

❏ If you use an extension cord with the printer, make sure that 
the total ampere rating of the devices that are plugged into 
the extension cord does not exceed the cord’s ampere rating. 
Also, make sure that the total ampere rating of all devices that 
are plugged into the wall outlet does not exceed the wall 
outlet’s ampere rating.
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❏ Do not attempt to service the printer yourself.

❏ Unplug the printer and refer servicing to qualified service 
personnel under the following conditions:

The power cord or plug is damaged; liquid has entered the 
printer; the printer has been dropped or the cabinet damaged; 
the printer does not operate normally or exhibits a distinct 
change in performance.

❏ If you plan to use the printer in Germany, the building 
installation must be protected by a 10 or 16 amp circuit 
breaker to provide adequate short-circuit protection and 
over-current protection for this printer.

Note for German-speaking users:
Bei Anschluss des Druckers an die Stromversorgung muss 
sichergestellt werden, dass die Gebäudeinstallation mit einer 10 A- 
oder 16 A-Sicherung abgesichert ist.

A Few Precautions

Read the information in this section before using the printer, 
handling the ink cartridges, or choosing a location for the printer.

Using the printer

Observe the following when using the printer.

❏ Do not put your hand inside the printer or touch the ink 
cartridges during printing.

❏ Do not move the print head by hand; otherwise, you may 
damage the printer.
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❏ Always turn the printer off using the P power button. When 
this button is pressed, the P power light flashes briefly and 
then goes off. Do not unplug the printer or turn off the power 
to the outlet until the P power light stops flashing.

❏ Before transporting the printer, make sure that the print head 
is in the home (far right) position and that the ink cartridges 
are in place.

Handling the ink cartridges

Observe the following when handling the ink cartridges.

❏ Keep ink cartridges out of the reach of children. Do not allow 
children to drink from or otherwise handle the cartridges.

❏ Be careful when you handle the used ink cartridges, as there 
may be some ink around the ink supply port. If ink gets on 
your skin, wash the area thoroughly with soap and water. If 
ink gets in your eyes, flush them immediately with water. If 
discomfort or vision problems remain after a thorough 
flushing, see a doctor immediately.

❏ Do not shake an ink cartridge; this can cause leakage.

❏ Install an ink cartridge immediately after you remove it from 
its package. Leaving the cartridge unpacked for a long time 
before use may result in reduced print quality.

❏ Once you install an ink cartridge, do not open the clamp or 
remove the cartridge except to replace it with a new one. 
Otherwise, the cartridge may become unusable.

❏ Do not use an ink cartridge beyond the date printed on the 
cartridge carton: otherwise, it may result in reduced print 
quality. For best results, use up the ink cartridges within six 
months of first installing them.
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❏ After bringing an ink cartridge inside from a cold storage site, 
allow it to warm up at room temperature for at least three 
hours before using it.

❏ Store ink cartridges in a cool, dark place.

❏ Do not dismantle the ink cartridges or try to refill them. This 
could damage the print head.

Choosing a place for the printer

Observe the following when choosing a place for the printer.

❏ Place the printer on a flat, stable surface that extends beyond 
the printer base in all directions. The printer will not operate 
properly if it is tilted or at an angle.

❏ Avoid places that are subject to rapid changes in temperature 
and humidity. Also, keep the printer away from direct 
sunlight, strong light, and heat sources.

❏ Avoid places that are subject to shocks and vibrations.

❏ Leave enough room around the printer to allow for sufficient 
ventilation.

❏ Avoid places subject to dust.

❏ Place the printer near a wall outlet where the plug can be 
easily unplugged.

Note for French-speaking users:
Placez l’imprimante près d’une prise de contacte où la fiche peut être 
débranchée facilement.
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ENERGY STAR Compliance

As an ENERGY STAR Partner, EPSON has determined 
that this product meets the ENERGY STAR guidelines 
for energy efficiency.

The International ENERGY STAR Office Equipment Program is 
a voluntary partnership with the computer and office equipment 
industry to promote the introduction of energy-efficient personal 
computers, monitors, printers, fax machines, copiers, and 
scanners, in an effort to reduce air pollution caused by power 
generation.

For United Kingdom Users

Use of options
EPSON (UK) Limited shall not be liable against any damages or 
problems arising from the use of any options or consumable 
products other than those designated as Original EPSON 
Products or EPSON Approved Products by EPSON (UK) Limited.

Safety information

w Warning:
This appliance must be earthed. Refer to the rating plate for 
voltage and check that the appliance voltage corresponds to the 
supply voltage.

Important:
The wires in the mains lead fitted to this appliance are coloured 
in accordance with the following code:

Green and yellow — Earth
Blue — Neutral
Brown — Live
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If you have to fit a plug:
As the colours of the mains lead for this appliance may not match 
the coloured markings used to identify the terminals in a plug, 
please proceed as follows:

The green and yellow wire must be connected to the terminal in 
the plug that is marked with the letter E or the earth symbol (G).

The blue wire must be connected to the terminal in the plug that 
is marked with the letter N.

The brown wire must be connected to the terminal in the plug that 
is marked with the letter L.

If damage occurs to the plug, replace the cord set or consult a 
qualified electrician.

Replace fuses only with a fuse of the correct size and rating.

Warnings, Cautions, and Notes

w Warnings
must be followed carefully to avoid bodily injury.

c Cautions
must be observed to avoid damage to your equipment.

Notes
contain important information and useful tips on the operation of your 
printer.
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Loading Plain Paper

Follow the steps below to load plain paper in the printer.

1. Lower the output tray and slide out the extension. Next, slide 
the left edge guide so that the distance between the edge 
guides is slightly wider than the width of your paper.

2. Fan a stack of paper, then tap it on a flat surface to even the 
edges.
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3. Load the stack of paper in the sheet feeder with the printable 
side up and the right edge of the paper resting against the 
right edge guide. Then slide the left edge guide against the 
left edge of the paper.

Note:
❏ Always load paper into the sheet feeder short edge first.

❏ Make sure that the paper stack fits under the arrow mark inside 
the edge guide.

Loading Special Paper and Other Media

You can achieve good results with most types of plain bond paper. 
However, using coated paper and glossy film will result in higher 
quality printouts because these types of media absorb smaller 
amounts of ink.

EPSON provides special type of media that are formulated for the 
ink used in EPSON ink jet printers. EPSON recommends using 
media that is distributed by EPSON to ensure high-quality results. 
See “Media types” on page 11-4 for a complete list of these 
products.
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When loading special media that is distributed by EPSON, read 
the instruction sheets packed with the media first and keep the 
points listed below in mind.

❏ Make sure that the printable side of the paper is facing up 
when loading media into the sheet feeder. See the instruction 
sheets packed with the media to determine which side is the 
printable surface. Some types of media have cut corners to 
help identify the correct loading direction, as shown in the 
illustration.

Note:
If you extend the printable area by selecting Maximum as the 
Printable Area setting in the printer driver, the cut corner on special 
paper may mar your printout.

❏ Make sure that the paper stack fits under the arrow mark that 
is located on the inside surface of the left edge guide.

cut corner

printable
side up
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❏ If the paper is curled, flatten it or curl it slightly toward the 
opposite side before loading it. Printing on curled paper may 
smear your printout, especially when printing with 
Maximum selected as the Printable Area setting.

❏ If ink smears on your documents when printing on thick 
media, set the adjust lever to the “+” position. To set the adjust 
lever, open the printer cover and position the lever as shown 
in the illustration.

Note:
❏ Return the adjust lever to the “0” position before printing on 

media of normal thickness. Leaving the lever in the “+” position 
may cause gaps in the printed image. 
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❏ When the adjust lever is in the “+” position, make sure that the 
High Speed check box in the printer driver’s Advanced dialog 
box is cleared. To clear this check box, you may also need to 
change the Print Quality setting or align the print head using 
the Print Head Alignment utility.

❏ If you wish to print on the reverse side of an Ink Jet Card with 
Maximum selected as the Printable Area setting, flatten the 
card or curl it slightly toward the opposite side before loading. 
Set the adjust lever to the “+” position before printing.
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Loading capacities for EPSON special media

See below to find the loading capacities for EPSON special media.

* Do not print on support sheets that are loaded under special media.

Media Type Loading Capacity

360 dpi Ink Jet Paper and 
Photo Quality Ink Jet 
Paper

Up to the arrow mark on the left edge 
guide.

Photo Quality Ink Jet 
Cards, Ink Jet Note 
Cards, and Ink Jet 
Greeting Cards

Up to 30 cards.
Always place the included support sheet* 
under the cards.

Photo Quality Glossy Film One sheet at a time or a maximum of 20 
sheets. When loading multiple sheets, set 
the minimum top margin of the page to 
30 mm.
Always put a support sheet* or a sheet of 
plain paper under the glossy film.

Ink Jet Transparencies Up to 30 transparencies.
Always put a sheet of plain paper under 
the stack of transparencies.

Photo Quality Self 
Adhesive Sheets

One sheet at a time.

Photo Paper Up to 20 sheets.
For 200 × 300 mm Photo Paper, you can 
only load one sheet at a time. Always put 
a support sheet* under the stack of Photo 
Paper.

Premium Glossy Photo 
Paper

One sheet at a time.

Photo Stickers 16 and 
Photo Stickers 4

One sheet at a time.

Panoramic Photo Paper 
and Iron-On Cool Peel 
Transfer Paper

One sheet at a time.

Matte Paper-
Heavyweight

Up to 20 sheets.
Always put a support sheet* under the 
stack of Matte Paper-Heavyweight.
1-6      Paper Handling



About special media cleaning sheets

Cleaning sheets that are packaged with EPSON special media 
should not be used with this printer. The cleaning function 
performed by these sheets is not necessary with this type of 
printer and the sheets may jam in the printer.

Loading Envelopes

When printing on envelopes, please note the following:

❏ You can load up to 10 envelopes in the sheet feeder.

Note:
The folding quality and thickness of envelopes varies widely. If the 
total thickness of the stack of envelopes exceeds 10 mm, press each 
envelope in the stack flat before loading.

❏ Set the adjust lever to the “+” position. To do this, open the 
printer cover and reposition the lever.

Note:
❏ Return the adjust lever to the “0” position, which is the normal 

position, after you finish printing on envelopes. Leaving the 
lever in the “+” position may cause gaps to appear in images 
that are printed on other media.

❏ When the adjust lever is in the “+” position, make sure that the 
High Speed check box in the printer driver’s Advanced dialog 
box is cleared. To clear this check box, you may also need to 
change the Print Quality setting.
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❏ Load envelopes flap edge first with the flap side down, as 
shown in the illustration.

❏ Do not use envelopes that are curled or folded. Flatten the 
envelope flaps before loading. Avoid using envelopes that are 
too thin as they may curl during printing.

❏ Select Plain Paper as the Media Type setting in the printer 
driver.

Using EPSON Photo Paper (4 x 6 inch, 
200 x 300 mm)

EPSON Photo Paper (S041134, S041254) is perforated around the 
margins so that you can trim your printed images to look like 
4 × 6 inch (102 × 152 mm) or 200 × 300 mm photographs.

Loading Photo Paper

Note the following when loading EPSON Photo Paper.

Available envelopes sizes are:
No.10, DL, C6, 132 mm × 220 mm
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❏ Load the paper printable side up with the perforated margins 
positioned as shown in the illustration.

❏ Use flat, undamaged paper. If the paper or the support sheet 
is curled, flatten it before loading to avoid paper feeding 
problems.

❏ Always place the included support sheet under the stack of 
Photo Paper, but do not print on it.

❏ You can load up to 20 sheets of 4 × 6 inch Photo Paper or one 
sheet of 200 × 300 mm Photo Paper in the sheet feeder.

❏ Do not fold the paper before printing.

❏ Cut or tear the paper at the perforation only after printing.

❏ Select Photo Paper as the Media Type setting and Photo 
Paper 4 × 6 in or Photo Paper 200 × 300 mm as the Paper 
Size setting in your printer driver.

loading position
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Removing the perforated margins

To remove the perforated margins, fold the paper back and forth 
a few times along the perforations, then carefully tear the margins 
off. You can also remove the margins by cutting along the 
perforations.

Keep in mind that the edges of your image might be cut off when 
you remove the perforated margins. Refer to the illustrations 
below for the dimensions of Photo Paper.
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4 x 6 inch Photo Paper

17 mm (0.67 in.)

trimmed size

printed image size

6 mm (0.24 in.)

3 mm 6 mm

3 mm (0.12 in.)
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200 x 300 mm Photo Paper

Storing EPSON Photo Paper

Keeps the following points in mind when storing Photo Paper.

❏ Return unused paper to its original package as soon as you 
finish printing and avoid storing it in places exposed to high 
temperature, humidity, or direct sunlight.

❏ EPSON recommends storing your printouts in a resealable 
plastic bag and keeping them away from high temperatures, 
humidity, and direct sunlight.

19 mm (0.75 in.)

trimmed size

printed image size
8 mm (0.31 in.)

5 mm 19 mm

5 mm (0.2 in.)
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Double-Sided Printing
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Using Double-Sided Printing

The EPSON Stylus COLOR 980 allows double-sided printing. 
There are two types of double-sided printing available. Standard 
double-sided printing allows you to print the odd-numbered 
pages first. Once these are printed, you can reload the printouts 
in the sheet feeder and print the even-numbered pages on the 
other side of the paper. Folded Booklet double-sided printing 
allows you to make single-fold booklets. For more details about 
making single-fold booklets and double-sided printing, refer to  
“Making the Layout menu settings” on page 3-23 for Windows, 
or “Making the Page Setup settings” on page 5-12 for Macintosh.

Note:
❏ Double-sided printing via a network is possible when the High-

Speed Printing is set to ON in EpsonNet Direct Print Version 2 or 
higher, running on the server. For details, please refer to the Readme 
file on the Printer software CD-ROM.

❏ You can load up to 30 sheets of paper at one time when double-sided 
printing; however, the loading capacity of the sheet feeder varies, 
depending on the media type.

❏ Only use media types which are suitable for double-sided printing. 
Otherwise, the printout quality may deteriorate.

❏ This feature is not available for Windows 3.1 users.

❏ Depending on the type of paper and the amount of ink used to print 
text and images, ink may bleed through to the other side of the paper.
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For Windows users, select the Double-Sided Printing check box 
on the Layout menu of your printer driver to use the double-sided 
printing feature. To access your printer driver, see “Accessing the 
printer software” on page 3-2. 

For Macintosh users, select the Double-Sided Printing check box 
in the Page Setup dialog box. For information on making settings 
in this dialog box, see “Making Changes to Printer Settings” on 
page 5-2.
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Once the Double-Sided Printing check box is selected, it is 
possible to make the following double-sided printing settings.

Margins

Click this button to open the Margins dialog box, where you can 
specify which edge the binding will be on. You can choose 
between Left, Top, and Right. You can also specify the width of 
the binding margin by entering a value in the Binding Margin text 
box.

Folded Booklet

Select this check box to make single-fold booklets. For more 
details on this feature, refer to “Making the Layout menu settings” 
on page 3-23 for Windows, or “Making the Page Setup settings” 
on page 5-12 for Macintosh.
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Once you have made your settings, click OK to save them. Load 
paper in the sheet feeder, then send the print job from your 
application. The odd-numbered pages will print first, unless 
Folded Booklet is selected. While the printer is printing the odd-
numbered pages, instructions are displayed which explain how 
to reload the paper correctly. Follow the instructions to reload the 
paper, then click Resume to print the even-numbered pages.
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Printer Software Introduction

The printer software CD-ROM which comes with your printer 
includes a printer driver and printer utilities. The printer driver 
lets you choose from a wide variety of settings to achieve the best 
results with your printer. The printer utilities help you to check 
the printer and keep it in top condition.

Getting more information

For information on using the printer driver, see “Making Changes 
to Printer Settings” on page 3-4.

For information on using the printer utilities, see “Using the 
Printer Utilities” on page 3-37.

Note:
The specific features available in the printer software vary, depending 
on the version of Windows that you are using.

Online help provides more information about the printer 
software. See “Getting Information Through Online Help” on 
page 3-43 for instructions on accessing help.

Accessing the printer software

You can access the printer software from most Windows 
applications, from the Windows Start menu (Windows 98, 95, 
2000, and NT 4.0), or from the Control Panel (Windows 3.1).

When you access the printer software from a Windows 
application, the settings that you make apply only to the 
application that you are using.

When you access the printer software from the Start menu, the 
settings that you make apply to all of your Windows applications.
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Refer to the appropriate section below.

From Windows applications
Follow the steps below to access the printer software from 
Windows applications.

1. From the File menu, click Print or Print Setup.

2. In the dialog box that appears, click Printer, Setup, Options, 
or Properties. (Depending on your application, you may need 
to click a combination of these buttons.) The printer driver 
opens.

From the Windows Start menu (Windows 98, 95, 2000, and 
NT 4.0)

Follow the steps below to access the printer software from the 
Start menu.

1. Click Start, point to Settings, then click Printers.

2. For Windows 98 and 95, select your printer, then click 
Properties on the File menu. For Windows 2000, select your 
printer, then click Printing Preferences on the File menu. For 
Windows NT 4.0, select your printer, then click Document 
Defaults on the File menu. The printer driver opens.

From the Control Panel (Windows 3.1)
Follow the steps below to access the printer software from the 
Control Panel in Windows 3.1.

1. Double-click the Control Panel icon in the Main program 
group.

2. Double-click the Printers icon.

3. Select your printer in the Installed Printers list.
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4. Click Setup. The printer driver opens.

Making Changes to Printer Settings

The printer driver features the following menus and settings.

Note:
The Layout menu is available only for Windows 98, 95, 2000, and 
NT 4.0 users.

The Mode settings on the Main menu are arranged to give you 
three levels of control over the printer driver, as explained below.

Main: Media Type, Ink, Mode, Print Preview

Paper: Paper Size, Copies, Orientation, Printable Area

Layout: Reduce/Enlarge, Double-Sided Printing, Multi-Page, 
Watermark

Automatic This mode provides the quickest and 
easiest way to start printing. See “Using 
the Automatic mode” on page 3-9 for 
details.

PhotoEnhance This mode lets you choose from a variety 
of image-correction settings specially 
designed for printing photos. See “Using 
the PhotoEnhance mode” on page 3-10 
for details. 

Custom This mode lets you choose from a list of 
ready-made or personalized settings 
suited to the kind of document that you 
want to print. When Custom is selected, 
the Advanced button is enabled, 
allowing you to access the Advanced 
dialog box. See “Using the Custom 
mode” on page 3-11 for details. 
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In addition to making comprehensive Mode settings that affect 
overall print quality, you can also modify individual aspects of 
your printout using the Paper and Layout menus. See “Modifying 
the printout style” on page 3-21.

Making the Media Type setting

The Media Type setting determines what other settings are 
available, so you should always make this setting first.

On the Main menu, select the Media Type setting that matches 
the media that is loaded in the printer. To determine what Media 
Type you are using, locate your media in the list below, and refer 
to the corresponding Media Type under which it is grouped 
(shown in larger type). For some types of media, there are several 
Media Type settings to choose from.

Note:
For Windows 3.1 users, if the Media Type that you wish to select does 
not appear in the list, make the Print Quality setting in the More 
Settings dialog box first. To access this dialog box, click the Advanced 
button on the Main menu, then click More Settings.

Plain Paper

Plain paper

Envelopes

EPSON Premium Ink Jet Plain Paper (A4) S041214
Using the Printer Software for Windows      3-5



360 dpi Ink Jet Paper

Photo Quality Ink Jet Paper

EPSON 360 dpi Ink Jet Paper (A4) S041059
S041025

EPSON 360 dpi Ink Jet Paper (Letter) S041060
S041028

EPSON Iron-On Cool Peel Transfer Paper (A4) S041154

EPSON Iron-On Cool Peel Transfer Paper (Letter) S041153
S041155

EPSON Photo Quality Ink Jet Paper (A4) S041061
S041026

EPSON Photo Quality Ink Jet Paper (Letter) S041062
S041029

EPSON Photo Quality Ink Jet Paper (Legal) S041067
S041048

EPSON Photo Quality Ink Jet Cards (A6) S041054

EPSON Photo Quality Ink Jet Cards (5 × 8”) S041121

EPSON Photo Quality Ink Jet Cards (8 × 10”) S041122

EPSON Photo Quality Self Adhesive Sheets (A4) S041106

EPSON Ink Jet Note Cards A6 (with envelopes) S041147

EPSON Ink Jet Greeting Cards 5 × 8” 
(with envelopes)

S041148

EPSON Ink Jet Greeting Cards 8 × 10” 
(with envelopes)

S041149
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Matte Paper-Heavyweight

Photo Paper

Photo Quality Glossy Film

EPSON Matte Paper-Heavyweight (A4) S041256
S041258
S041259

EPSON Matte Paper-Heavyweight (Letter) S041257

EPSON Photo Paper (A4) S041140

EPSON Photo Paper (Letter) S041141

EPSON Photo Paper (4 × 6”) S041134

EPSON Photo Paper (100 × 150 mm) S041255

EPSON Photo Paper (200 × 300 mm) S041254

EPSON Panoramic Photo Paper (210 × 594 mm) S041145

EPSON Photo Paper Cards (A4) S041177

EPSON Photo Quality Glossy Film (A4) S041071

EPSON Photo Quality Glossy Film (Letter) S041072

EPSON Photo Quality Glossy Film (A6) S041107

EPSON Photo Stickers 16 (A6) S041144

EPSON Photo Stickers 4 (A6) S041176
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Ink Jet Transparencies

Premium Glossy Photo Paper

Note:
The availability of special media varies by location.

EPSON Ink Jet Transparencies (A4) S041063

EPSON Ink Jet Transparencies (Letter) S041064

EPSON Premium Glossy Photo Paper (A4) S041287
S041297

EPSON Premium Glossy Photo Paper (Letter) S041286
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Using the Automatic mode

When Automatic is selected as the Mode setting on the Main 
menu, the printer driver takes care of all detailed settings based 
on the current Media Type and Ink settings. To make the Ink 
setting, select Color to print in color, or Black to print in black-
and-white or grayscale. To make the Media Type setting, see 
“Making the Media Type setting” on page 3-5.

Note:
❏ Depending on the media that is selected in the Media Type list (while 

Automatic is selected), a slider appears under the Custom radio 
button that lets you choose either Quality or Speed. Select 
Quality when print quality is more important than speed.

❏ Most Windows applications feature paper size and page layout 
settings that override similar settings in the printer driver. 
However, if your application does not have these settings, verify the 
settings on the printer driver’s Paper menu.
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Using the PhotoEnhance mode

The PhotoEnhance mode provides a variety of image-correction 
settings that you can apply to your photo images before printing. 
PhotoEnhance does not affect your original data.

Note:
❏ This mode is only available when printing 16-, 24-, or 32-bit color 

data.

❏ Printing with PhotoEnhance selected may increase the time 
required for printing, depending on your computer system and the 
amount of data contained in your image.

You can select from the following PhotoEnhance settings.

Standard This setting provides standard image correction for 
most photos. Try this first.

People This setting is best for photos of people.

Nature This setting is best for outdoor scenery such as 
mountains, sky, and oceans.
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Selecting PhotoEnhance also enables the Digital Camera 
Correction check box. Select this check box when you are 
printing photos taken with a digital camera to give your printed 
images the smooth, natural appearance of photographs taken 
with a film camera.

Using the Custom mode

The Custom mode offers ready-made settings designed for 
printing text and graphs and for applying a color-matching 
method. You can also create and save your own custom settings. 
Refer to the appropriate section below.

Soft Focus This setting makes your photos look as if they were 
taken with a soft-focus lens.

Sepia This setting applies a sepia tone to your photos.
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You can select from the following ready-made settings.

When you select a Custom setting, other settings such as Print 
Quality, Halftoning, and Color Adjustment are made 
automatically. Changes to these settings are reflected in the 
display on the left side of the Main menu.

Follow the steps below to select a Custom setting.

1. Select Custom as the Mode setting on the Main menu.

Note:
For Windows 3.1 users, the Custom radio button referred to above 
appears as the Advanced radio button in the printer driver.

2. Click anywhere in the list box to open it, then select the most 
appropriate setting for the type of document or image that 
you will print.

3. Verify the Media Type and Ink settings before printing, as 
these settings may be affected by the Custom setting that you 
select. See “Making the Media Type setting” on page 3-5 for 
details.

Text/Graph This setting is good for printing 
presentation documents such as graphs 
and charts.

Economy This setting is best for printing drafts of text.

ICM

(For Windows 98, 95, 
and 2000)

This setting automatically adjusts printout 
colors to match the colors on your screen. 
ICM stands for Image Color Matching.

sRGB This setting is best for color matching with 
other sRGB devices.
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Making Advanced settings
Note:
In the Windows 3.1 driver, the names of the buttons on the Main menu 
differ from those described here. The Custom radio button appears as 
the Advanced radio button, and the Advanced button appears as 
the More Settings button.

The settings in the Advanced dialog box give you complete 
control over your printing environment. Use these settings to 
experiment with new printing ideas or to fine-tune a range of 
print settings to meet your individual needs. Once you are 
satisfied with your new settings, you can give them a name and 
add them to the Custom Settings list on the Main menu.

Follow the instructions in this section to make Advanced settings.

Note:
The printer driver screens that appear in this procedure are for 
Windows 98 and 95. The Windows 3.1, 2000, and NT 4.0 printer driver 
screens differ slightly in appearance. The instructions for the 
Windows 3.1 printer driver differ as noted below.
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1. Select Custom as the Mode setting on the Main menu and 
then click Advanced. For Windows 3.1 users, select 
Advanced, then click More Settings. The following dialog 
box appears.

2. Select the Media Type that is loaded in the printer. For details, 
see “Making the Media Type setting” on page 3-5.

3. Choose Color or Black as the Ink setting.

4. Specify a Print Quality setting.

5. Make other settings as necessary. For details, see online help.

Note:
❏ The PhotoEnhance option under Color Management only 

affects images, not text or graphs. For example, if 
Monochrome is selected in the Tone list (enabled when 
PhotoEnhance is selected), only the images in a document 
will be printed in monochrome. Any colored text or graphs in 
the same document will be printed in color.
3-14      Using the Printer Software for Windows



❏ Some settings may be unavailable, depending on the Media 
Type, Ink, and Print Quality settings that you make.

6. Click OK to apply your settings and return to the Main menu. 
If you want to return to the Main menu without applying your 
settings, click Cancel. To save your Advanced settings, 
proceed to the next section.

Saving and deleting your settings
To save your Advanced settings in the Custom Settings list, click 
Save Settings in the Advanced dialog box. For Windows 3.1 
users, click Save Settings on the Main menu. The Custom 
Settings dialog box appears.

Type a unique name for your settings in the Name text box, then 
click Save. Your Advanced settings will be added to the Custom 
Settings list.

Note:
❏ You cannot apply the names of EPSON ready-made settings to your 

custom settings.
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❏ You cannot delete the ready-made settings from the Custom Settings 
list.

To delete a setting from the Custom Settings list, select it in the 
Custom Settings dialog box and click Delete.

Using your saved settings
To use your saved settings, select Custom as the Mode setting on 
the Main menu, then select your settings in the Custom Settings 
list, located to the right of the Custom radio button.

Note:
For Windows 3.1 users, the Custom radio button referred to above 
appears as the Advanced radio button in the printer driver.

If you change the Media Type or Ink settings while one of your 
customized settings is selected in the Custom Settings list, the 
selection shown in the list returns to Custom Settings. The 
customized setting that was previously selected is not affected by 
the change. To return to your customized setting, simply reselect 
it in the list.
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Previewing your printout

Select the Print Preview check box on the Main menu to see a 
preview of your document before printing.

Note:
This feature is not available for Windows 3.1.
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When you send a print job to the printer, the Print Preview 
window opens, allowing you to make changes before printing.

The Preview dialog box contains several icon buttons that allow 
you to perform the following functions.

Selection Click this button to select and move 
watermarks.

Zoom Click this button to enlarge or reduce 
the size of the previewed page.

Fit-to-screen Click this button to scale the previewed 
page so that it fits the size of the window. 
This is convenient when you want to see 
the entire page at one time.

Maximum 
zoom

Click this button to display the 
previewed page at the maximum 
possible zoom ratio.
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You can also manipulate the previewed document in the 
following ways:

❏ Select and preview individual pages.

❏ Reduce or enlarge the size of the preview.

❏ Select and print any or all pages. 

❏ Magnify the previewed document. To do this, click View and 
then Magnify to open the Magnify window, which magnifies 
the area of the previewed document which is outlined by a 
red box. By dragging the red box, you can change which part 
of the document is magnified.

Printable 
area on/off

Click this button to display a rectangle 
on the page being previewed. This 
rectangle outlines the printable area for 
the page. The printer cannot print 
anything which is outside of this 
rectangle. Click the button again to turn 
this feature off.

Watermark Click this button to open the Watermark 
Settings dialog box, where you can 
change any of the current watermark 
settings.

Reset 
watermark 
settings

Click this button to return all watermark 
settings to what they were when the 
Print Preview window was first opened. 
If nothing has been changed, this 
button is unavailable.

Previous 
page

Click this button to display the page 
previous to the one currently being 
previewed. If there is no previous page, 
this button is unavailable.

Next page Click this button to display the next page 
in the document. If there is no next 
page, this button is unavailable.
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❏ View the individual pages that comprise a poster. The Poster 
window opens automatically when you send a print job while 
Poster is selected as the Multi-Page option on the Layout 
menu. From this window, you can view the individual pages 
which make up a poster. You can also open this dialog box by 
clicking View and then Poster.

❏ Apply watermarks. The watermark that you select will 
appear in the previewed image. For detailed information on 
customizing watermarks, see “Printing a watermark on your 
document” on page 3-34. 

❏ Specify which pages in the document you would like printed 
using the Add and Remove features. To add or remove a page, 
you must first click the page icon in the list appearing at the 
left side of the preview window. Then add or remove it using 
the commands on the Print Options menu.

Note:
❏ When using the double-sided printing feature, the Preview window 

allows you to toggle between pages in the print job by clicking the 
appropriate page in the list at the left side of the screen. The pages 
are listed in two columns, Front and Back. The pages in the Front 
column will print first. The page numbers listed refer to pages of the 
print job, and may contain more than one document page.

❏ If it is necessary to reprint part of a double-sided print job, select 
each page of the print job that does not need to be reprinted in the 
list at the left side of the screen, then click Remove Page on the 
Print Options menu. Make sure that the paper is loaded properly so 
that the print job will start on the correct side of the correct page.

After you have previewed the document, click Print to print the 
document, or click Cancel to cancel printing.

Add page Click this button to add the highlighted 
pages to the list of pages to be printed. 

Remove 
page

Click this button to remove the 
highlighted pages from the list of pages 
to be printed.
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Modifying the printout style

You can modify the style of your printout using a variety of 
printer driver settings located on the Paper and Layout menus.

Note:
The Layout menu is not available in the Windows 3.1 printer driver.

On the Paper menu, you can specify the paper size, the number 
of copies, the orientation of your printout, and the printable area. 
On the Layout menu, you can automatically match the document 
size to the paper size, print on both sides of the paper, print two 
or four pages on a single sheet of paper, print poster-size images 
by enlarging one page to cover several sheets, or place 
watermarks on documents. Refer to the appropriate section below 
for details.
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Making the Paper menu settings

Use the settings on the Paper menu to change the paper size, set 
the number of copies and other copy parameters, specify the 
paper orientation, and adjust the printable area.

You can make the following settings on the Paper menu:

Paper Size Select the paper size that you wish to use. You can 
also add a custom paper size.

Copies Select the number of copies that you wish to print. 
You can select Collate to print one set at a time or 
Reverse Order to print your documents in reverse 
order, starting with the last page.

Orientation Select Portrait (tall) or Landscape (wide) to change 
the orientation of your printout. If you need to print 
closer to the bottom of the page, select the Rotate 
by 180° check box.
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Making the Layout menu settings

Use the settings on the Layout menu to modify the page layout of 
your document by matching the document size to the paper size, 
or by allowing printing on both sides of the paper, printing two 
or four pages on a single sheet of paper, printing poster-size 
images by enlarging one page to cover several sheets, or printing 
watermarks.

Note:
The Layout menu is not available in the Windows 3.1 printer driver.

Fitting your document to the paper size
Use the Reduce/Enlarge options on the Layout menu to fit your 
document to the paper size that you will print on.

Printable Area Select Centered to center the printout. Select 
Maximum to increase the printable area.

Note:
When Maximum is selected, print quality may 
decline at the edges of the printout. Before printing 
large jobs using this setting, print a single sheet to 
confirm quality.
When Maximum is selected, make sure that the 
paper loaded in the paper feeder is not curled.
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Note:
The Layout menu is not available in the Windows 3.1 printer driver.

You can select from the following settings.

Normal Prints your document at its normal size.

Fit to Page Proportionally enlarges or reduces the size of 
your document to make it fit the paper size 
that you select in the Paper Size list on the 
Paper menu.

Custom Allows you to manually enlarge or reduce the 
size of your document. Use the arrows next to 
the Scale to box to select a percentage 
between 10% and 400%.
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Printing on both sides of the paper
The EPSON Stylus COLOR 980 allows double-sided printing. 
There are two types of double-sided printing available. Standard 
double-sided printing allows you to print the odd-numbered 
pages first. Once these are printed, you can reload the printouts 
in the sheet feeder and print the even-numbered pages on the 
other side of the paper. Folded Booklet double-sided printing 
allows you to make single-fold booklets. Refer to the appropriate 
section below.

Note:
❏ Double-sided printing via a network is possible when the EPSON 

high-speed port is set to ON in EpsonNet Direct Print Version 2 or 
higher, running on the server. For details, please refer to the Readme 
file on the Printer software CD-ROM.

❏ You can load up to 30 sheets of paper at one time when double-sided 
printing; however, the loading capacity of the sheet feeder varies, 
depending on the media type.

❏ Only use media types which are suitable for double-sided printing. 
Otherwise, the printout quality may deteriorate.

❏ Depending on the type of paper and the amount of ink used to print 
text and images, ink may bleed through to the other side of the paper.

Standard double-sided printing

Follow the steps below to print first the odd-numbered pages, and 
then the even-numbered pages after you have reloaded the 
printouts.

1. Select the Double-Sided Printing check box on the Layout 
menu of your printer driver. For information on accessing the 
Layout menu, see “Accessing the printer software” on page 
3-2.
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Note:
The Layout menu is not available in the Windows 3.1 printer driver.

2. Click the Margins button. The following dialog box opens.

3. Specify which edge of the paper the binding will be on. You 
can choose between Left, Top, and Right.
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4. Specify the width of the binding margin by entering a value 
in the Binding Margin text box. You can specify a value 
between 3 mm and 30 mm.

Note:
The actual binding margin may vary, depending on your 
application. Experiment by printing a few sheets using different 
binding margin values before printing the entire job; otherwise, the 
results may differ from what you expect.

5. Click OK to return to the Layout menu, then click OK to save 
your settings.

6. Load paper in the sheet feeder, then send the print job from 
your application. While the printer is printing the odd-
numbered pages, instructions are displayed which explain 
how to reload the paper correctly.

7. Follow the instructions to reload the paper, or reload the 
paper as shown in the illustration below.

Note:
❏ The paper may curl during printing, depending on the amount 

of ink used to print text and images. Flatten it or curl it slightly 
toward the opposite side before printing on the other side of the 
paper.

❏ Tap the stack of paper on a flat surface to align the edges before 
reloading it.

❏ Reload the printouts as instructed; otherwise, the paper may 
jam or the binding margin may differ from what you expect.
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❏ If the paper jams, see “Paper Does Not Feed Correctly” on page 
10-23.

8. Once the paper is reloaded, click Resume to print the even-
numbered pages.
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Folded Booklet double-sided printing

You can also make single-fold booklets using the double-sided 
printing feature. When booklet printing, the printer first prints 
the pages which will be on the outside after you fold the paper, 
and then prints the inside pages after you reload the paper, as 
shown in the illustration below.

In this example, the printer would print pages 1 and 4 of your 
document on the first sheet of paper, pages 5 and 8 on the second 
sheet of paper, and pages 9 and 12 on the third sheet of paper. 
After you reload the printouts in the sheet feeder, the printer 
would then print pages 2 and 3 on the back of the first sheet of 
paper, pages 6 and 7 on the back of the second sheet of paper, and 
10 and 11 on the back of the third sheet of paper. After printing is 
finished, you can fold each sheet of paper and bind them together.

Follow the steps below to print booklets.

1. Select the Double-Sided Printing check box on the Layout 
menu, then select the Folded Booklet check box.

Note:
The Layout menu is not available in the Windows 3.1 printer driver.

Single-fold booklet

Binding Edge

1

2 4

3 5 9

6

7

8 10

11

12
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2. Click the Margins button. The Margins dialog box opens.

3. Specify which edge of the paper the binding will be on. You 
can choose between Left, Top, and Right.

Note:
While Portrait is selected as the Orientation setting on the Main 
menu of your printer driver, you can choose between Left and 
Right. While Landscape is selected as the Orientation setting, 
you can only select Top.

4. Specify the width of the binding margin by entering a value 
in the Binding Margin text box. You can specify a value 
between 3 mm and 30 mm. This margin width will be inserted 
on both sides of the fold. For example, if you specify a value 
of 10 mm, a 20-mm margin will be inserted, with 10 mm on 
each side of the fold.

5. Click OK to return to the Layout menu, then click OK to save 
your settings. 

6. Load paper in the sheet feeder, then send the print job from 
your application.

Margin

Folding 
Edge

portrait Landscape
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7. While the printer is printing the outside pages, instructions 
are displayed which explain how to reload the paper 
correctly. Follow the on-screen instructions to reload the 
paper, or reload the paper as shown in the illustration in the 
previous section, “Standard double-sided printing” on page 
3-25. 

Note:
❏ The paper may curl during printing, depending on the amount 

of ink used to print text and images. Flatten it or curl it slightly 
toward the opposite side before printing on the other side of the 
paper.

❏ Tap the stack of paper on a flat surface to align the edges before 
reloading it.

❏ Reload the printouts as instructed; otherwise, the paper may 
jam or the binding margin may differ from what you expect.

If the paper jams, see “Paper Does Not Feed Correctly” on page 
10-23.

8. Once the paper is reloaded, click Resume to print the inside 
pages. 

9. Once printing is complete, fold the printouts properly and 
bind them together using a stapler or other binding method.

Printing two or four pages on one sheet
Select N-up as the Multi-Page setting on the Layout menu to print 
two or four pages of your document on one sheet of paper.
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Note:
The Layout menu is not available in the Windows 3.1 printer driver.

You choose from the following settings:

Printing posters
A single document page can be enlarged to cover 4, 9, or 16 
printed sheets of paper. Select Poster as the Multi-Page setting on 
the Layout menu to print a poster-size image.

2 Pages
4 Pages

Prints two or four pages of your document on 
a single piece of paper.

Page Order Opens the Print Layout dialog box, where you 
can specify the order in which the pages will 
be printed on the sheet of paper. Some 
settings may be unavailable, depending upon 
your Orientation selection on the Paper menu.

Print page 
frames

Prints a frame around each page that is 
printed on the sheet of paper.
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Note:
The Layout menu is not available in the Windows 3.1 printer driver.

Click the Settings button to adjust the way that your poster will 
print. The Poster Settings dialog box opens.

You can make the following settings:

Overlapping 
Panels

Slightly overlaps the images so that they can be 
aligned more precisely.

Print Cutting 
Guidelines

Prints border lines on the images to guide you 
when trimming the pages.
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If you only want to print a few of the panels without printing the 
entire poster, click the panels that you don’t wish to print, then 
click OK to close the Poster Settings dialog box.

Printing a watermark on your document
To print a watermark on your document, click anywhere in the 
Watermark list box on the Layout menu and select from the list 
of predefined watermarks. To make settings for a predefined 
watermark, proceed to “Making settings for your watermark” on 
page 3-36.

Note:
The Layout menu is not available in the Windows 3.1 printer driver.
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You can also add your own text-based or image-based 
watermarks to the Watermark list. To add a watermark to the list, 
click the Add/Del button. The following dialog box appears.

Refer to the appropriate section below to finish creating and 
configuring a custom watermark.

Creating an image-based watermark

Follow the steps below to finish creating an image-based 
watermark.

1. Select BMP.

2. Click the Browse button to specify the bitmap file that you 
want to use, then click OK.

3. Type a name for your watermark in the Name box, then click 
Save.

4. Click OK to return to the Layout menu.
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Creating a text-based watermark

Follow the steps below to finish creating a text-based watermark.

1. Select Text.

2. Type the text for your watermark in the Text box. The text that 
you enter will also be assigned to the watermark as a 
watermark name. If you want to change the watermark name, 
type a new name in the Name box, then click Save. 

3. Click OK to return to the Layout menu.

Making settings for your watermark

Follow the steps below to make settings for your watermark.

1. Select the desired Watermark in the Watermark list box on the 
Layout menu.

2. Click the Settings button. The following dialog box appears.
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3. Make sure that the appropriate watermark is selected in the 
Watermark list box, then make Color, Position, Density, Size, 
Font, Font Style and Angle settings. For details, please see 
online help. Your settings are reflected in the display at the 
left side of the dialog box. 

4. When you are finished making settings, click OK.

Using the Printer Utilities

The EPSON printer utilities allow you to check the current printer 
status and to perform some printer maintenance from your 
computer. 

To use the utilities, click the Utility tab in the printer driver, then 
click the icon button for the utility that you wish to use. For 
information on how to access the printer software, see “Accessing 
the printer software” on page 3-2.
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Note:
❏ The letter in parentheses after each utility name indicates the 

shortcut key for that utility. Press Alt and that letter on the keyboard 
to open the utility.

❏ Do not use the Nozzle Check, Head Cleaning, and Print Head 
Alignment utilities if your printer is connected to your computer 
through a network.

❏ Do not use the Nozzle Check, Head Cleaning, and Print Head 
Alignment utilities while printing is in progress; otherwise, your 
printout may be marred.

EPSON Status Monitor 3 (not available for 
Windows 3.1)

EPSON Status Monitor 3 provides you with printer status 
information such as the amount of ink remaining and checks for 
printer errors.

This utility is only available when both of the following conditions 
are met:

❏ The printer is connected directly to the host computer via the 
parallel port or the USB port.

❏ Your system is configured to support bidirectional 
communication.
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Nozzle Check

The Nozzle Check utility checks the print head nozzles for 
clogging. Check the nozzles if you notice that print quality has 
declined and after cleaning to confirm that the print head nozzles 
have been cleared. If the nozzle check indicates that the print head 
needs cleaning, you can access the Head Cleaning utility directly 
from the Nozzle Check utility. See “Checking the Print Head 
Nozzles” on page 9-1.

Head Cleaning

The Head Cleaning utility cleans the print head. You may need 
to clean the print head when you notice print quality has declined. 
Use the Nozzle Check utility first to confirm that the print head 
needs to be cleaned. You can access the Nozzle Check utility 
directly from the Head Cleaning utility. See “Cleaning the Print 
Head” on page 9-4 for details.

Print Head Alignment

The Print Head Alignment utility aligns the print head. Use this 
utility if you notice a misalignment of vertical lines. Follow the 
on-screen instructions to use this utility.
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Speed & Progress (not available for Windows 3.1)

Click the Speed & Progress button to open this dialog box, where 
you can make settings related to print speed and progress.

The available settings are as follows.

High Speed Copies

To print multiple copies of your document faster, select High 
Speed Copies.

Show Progress Meter

To monitor the progress of your print job, select Show Progress 
Meter.

EPSON Printer Port (for Windows 98 and 95 only)

To speed up the data transfer rate to EPSON printers, select 
EPSON Printer Port.
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If your computer supports ECP mode, enable DMA transfer to 
speed up printing.

For more details, see “Making Speed & Progress settings (not 
available for Windows 3.1)” on page 3-47.

Note:
You cannot make this setting if your printer is connected via the USB 
port.

Always Spool RAW Datatype (for Windows 2000 and NT 4.0 
only)

To have Windows NT-based clients spool documents using the 
RAW format instead of the EMF (metafile) format (Windows NT-
based applications use the EMF format by default), select the 
Always Spool RAW Datatype check box.

Try using this feature if documents spooled in EMF format do not 
print correctly.

Spooling RAW datatype requires less resources than EMF, so 
some errors, such as “Insufficient Memory/Disk Space to Print” 
and “Slow print speed”, can be solved by selecting the Always 
Spool RAW Datatype check box.

When spooling RAW datatype, print progress as displayed by the 
Progress Meter may differ from the actual print progress.

Monitoring Preferences

To open the Monitoring Preferences dialog box where you can 
make settings for EPSON Status Monitor 3, click this button. The 
settings are described in detail in the next section.
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Monitoring Preferences 

When you click the Monitoring Preferences button, the 
following dialog box appears.

The available settings are as follows: 

Select 
Notification

Displays the current error item notification settings. In 
this area, you can designate whether to have general 
error messages, communication error messages, or ink 
status messages displayed during printing, scanning, or 
copying. Select the check boxes that correspond to 
the error types for which you wish to receive 
notification.

Select 
Shortcut 
Icon 

Select the Shortcut Icon check box to have a shortcut 
icon placed in your Windows taskbar. Clicking the 
shortcut icon in the taskbar will open EPSON Status 
Monitor 3. To select which icon will be displayed, click 
the icon your prefer from the choices given; your 
selection will be shown at the right.
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Note:
Click the Default button to return all Select Notification settings to 
their default settings.

Getting Information Through Online Help

Your printer software has an extensive online help feature, which 
provides you with instructions on printing, making printer driver 
settings, and using the printer utilities. In Windows 98, 95, 2000, 
and NT 4.0, you can access online help from an application or from 
the Windows Start menu. In Windows 3.1, you can access online 
help through the EPSON program group. Refer to the appropriate 
section below.

Accessing help from an application

To access help from an application, open the application’s File 
menu and choose Print or Print Setup. Then click Printer, Setup, 
Options, or Properties. (Depending on the application, you may 
need to click a combination of these buttons.) Click Help at the 
bottom of the Main, Paper, Layout, and Utility menu for help 
related to that menu.

For Windows 98, 95, 2000, and NT 4.0, you can get specific help 
related to any item on a menu by right-clicking the item, then 
clicking the What's This? command in the shortcut menu that 
appears. The help contents window opens.

Allow 
monitoring 
of shared 
printers

Select this check box to allow a shared printer to be 
monitored by other computers.
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Accessing help from the Windows Start menu

To access help from the Start menu, click the Start button, point 
to Programs and then to Epson (for Windows 98 and 95) or 
EPSON Printers (for Windows 2000 and NT 4.0), then click 
EPSON Stylus COLOR 980 Help. The help contents window 
opens.

Accessing help from Windows 3.1

To access help in Windows 3.1, open the EPSON program group 
and click the EPSON Stylus COLOR 980 Help icon. The help 
contents window opens.

Increasing the Print Speed

Follow the instructions in this section to increase the printing 
speed of your printer.

General tips

Just as printing at a high resolution requires more processing time 
than printing at a low resolution, printing in color takes longer 
than printing in black because the volume of data in a color 
document is much greater. For this reason, it is important to be 
selective in your use of color if you also require a fast print speed.

However, even if your document requires the highest resolution 
and extensive use of color—for example, when you are printing 
a camera-ready composite that includes color photographs—it 
may still be possible to optimize the print speed by adjusting other 
printing conditions. Keep in mind that changing some conditions 
to increase the print speed may also lower print quality.
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The following table shows the factors that inversely affect print 
speed and print quality (increasing one will decrease the other).

Print quality
Print speed

Lower
Faster

Higher
Slower

Printer driver 
menu

Printer driver 
settings

Print Quality Economy, 
Normal

Photo Advanced 
dialog box

High Speed On Off

Finest Detail Off On

Data 
characteristics

Image size Small Large –

Resolution Low High
Using the Printer Software for Windows      3-45



The table below shows the factors related to print speed only.

 * Varies depending on the printer driver and application that you are using.

** Grayscale means using black ink only to print varying shades of gray, from 
pure black to pure white.

Print speed Faster Slower Printer driver 
menu

Printer driver 
settings

Ink Black Color Advanced 
dialog box, 
Main menu

Flip Horizontal* Off On Advanced 
dialog box

Collate* Off On Paper menu

Reverse Order* Off On

Data 
characteristics

Variety of 
colors

Grayscale** Full color –

Hardware 
resources

System speed Faster Slower –

HDD free 
space

Large Small

Memory free 
space

Large Small

Software status Applications 
running

One Many –

Virtual memory Not in use In use
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Making Speed & Progress settings (not available 
for Windows 3.1)

You can make certain print speed settings in the Speed & Progress 
dialog box. Click the Speed & Progress button on your printer 
software’s Utility menu. The following dialog box appears.

The following settings are available in the Speed & Progress 
dialog box.

High Speed Copies
Select this check box to turn on high-speed printing for multiple 
copies. This speeds up printing by using your hard disk space as 
a cache when printing multiple copies of your document.

EPSON Printer Port (for Windows 98 and 95 only)
Select this check box to enable the EPSON printer port, which is 
optimized for EPSON printers, instead of the Windows default 
printer port. This speeds up the data transfer rate to EPSON 
printers.
Using the Printer Software for Windows      3-47



Note:
This setting is unavailable when your printer is connected via the USB 
port.

Use DMA transfer (for Windows 98 and 95 only)
If your computer has a parallel port which supports ECP mode, 
you can enable DMA transfer to speed up printing. See your 
computer manual to determine if it supports ECP mode and DMA 
transfer.

To determine whether you need to enable DMA transfer, compare 
the message below the EPSON Printer Port check box to this table, 
and take the recommended action.

To enable DMA transfer, follow the steps below.

1. Double-click the My Computer icon on your desktop, then 
double-click the Control Panel icon.

Message Action

High Speed (DMA) 
Transfer enabled.

DMA transfer is already enabled. Click OK 
to close the dialog box.

For higher data transfer 
rates, use DMA Transfer.

Follow the steps below this table to enable 
DMA transfer.

(No message) Your system's parallel port setting does not 
allow DMA transfer. However, if you 
change the parallel port setting to ECP or 
Enhanced using your computer's BIOS 
Setup program, you may be able to use 
DMA transfer. Consult your computer 
manual or computer manufacturer for 
instructions. Once you change the 
parallel port setting, follow the steps 
below this table to enable DMA transfer.

Note:
Before you run the BIOS Setup program, 
uninstall the printer driver using 
Add/Remove Programs in the Control 
Panel. After running the BIOS Setup 
program, reinstall the printer driver.
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2. Double-click the System icon, then click the Device 
Manager tab.

3. Double-click the Ports (COM & LPT) icon and then LPT1. If 
you have connected your printer to a port other than LPT1, 
double-click the appropriate port icon.

4. Click the Resources tab, then clear the Use automatic 
settings check box. Write down the Input/Output Range 
settings shown in the resource settings box.

5. Select a basic configuration setting from the Setting based on 
list that uses the same Input/Output Range settings as those 
you wrote down in Step 4, and make sure that the Direct 
Memory Access channel and Interrupt Request numbers are 
allocated and displayed. Confirm also that the Conflicting 
device list box shows No conflicts.

6. Click OK to save the settings.

7. Reopen the Speed & Progress dialog box to confirm that DMA 
transfer has been enabled.
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Note:
You may be unable to use DMA transfer on some computers even 
after you make the settings described above. Consult your computer 
maker for information on the DMA transfer capabilities of your 
computer.

Making Configure LPT Port settings (for Windows 
NT 4.0 only)

Note:
Port settings for Windows NT 4.0 are complicated and should only be 
made by an experienced user with administrative privileges.

If your computer has a parallel port that supports ECP mode, you 
can make certain print speed settings in the Configure LPT Port 
dialog box. Before making settings, make sure that ECP mode has 
been selected in your computer settings. For details about ECP 
mode, see your computer manual.
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To access the Configure LPT Port dialog box, click the Start 
button, point to Settings, then click Printers. Select your printer 
and click Properties on the File menu. The printer driver opens. 
Click the Ports tab and then Configure Port. The following dialog 
box appears.

Click the LPT port tab for the port to which your printer is 
connected, then click the Change setting button.
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Note:
If your printer is connected to LPT1, only the LPT1 tab is available.

It is possible to make resource settings and enable DMA transfer 
in the Configure LPT Port dialog box. Refer to the appropriate 
section below.

Resource settings (IRQ and DMA)
If you have connected your printer to LPT2 or LPT3, making IRQ 
and DMA settings here may speed up printing. Input the same 
configuration numbers for IRQ and DMA which you have made 
for your expansion board. See your computer documentation to 
determine the settings for IRQ and DMA.

Use DMA Transfer
Using DMA transfer to send print data to the computer may help 
you speed up printing. If the Use DMA Transfer check box is not 
available, you must first enable DMA transfer in your computer 
settings. For details, see your computer documentation.
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Checking Printer Status and Managing 
Print Jobs for Windows
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Using the Progress Meter

When you send a print job to the printer, the Progress Meter 
opens, as shown in the illustration below.
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The Progress Meter indicates the progress of the current print job 
and provides printer status information when bidirectional 
communication between the printer and computer is established. 
This meter also displays error messages and helpful tips for better 
printing, as explained below.

Note:
The Progress Meter does not appear when the Show Progress Meter 
check box is cleared in the Speed & Progress dialog box. See “Speed & 
Progress (not available for Windows 3.1)” on page 3-40 for more 
information.

Viewing printing tips

Tips for getting the most out of your EPSON printer driver appear 
in the text box at the bottom of the Progress Meter window. A new 
tip appears every 30 seconds. For more details on a tip, click the 
Details button while that tip is displayed.
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Viewing error messages

If a problem occurs during printing, an error message appears in 
the text box at the top of the Progress Meter window. When the 
ink runs low or out, a How to button appears below the text box. 
Click How To and EPSON Status Monitor 3 will lead you 
step-by-step through the cartridge replacement procedure.

Using EPSON Spool Manager

EPSON Spool Manager is similar to Windows Print Manager. If 
it receives two or more print jobs at one time, it holds them in the 
order that they were received (with printers on a network this 
may be called a print queue). When a print job reaches the top of 
the line, the EPSON Spool Manager sends the job to the printer.

Note:
EPSON Spool Manager is not available for Windows NT.
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After you send a print job, an EPSON Stylus COLOR 980 button 
appears on the taskbar. Click this button to open the EPSON Spool 
Manager, where you can view print status information about the 
print jobs that have been sent to the printer. You can also cancel, 
pause and resume, or restart a print job by selecting it in the list 
and clicking the appropriate button.

Using EPSON Status Monitor 3

EPSON Status Monitor 3 displays detailed printer status 
information.

Note:
Before using EPSON Status Monitor 3, be sure to read its README 
file. To open this file, click Start, point to Programs and then to EPSON 
or EPSON Printers, then click EPSON Stylus COLOR 980 Readme.

Accessing EPSON Status Monitor 3

The two ways to access EPSON Status Monitor 3 are as follows:

❏ Double-click the printer-shaped shortcut icon on the 
Windows taskbar. To add a shortcut icon to the taskbar, see 
“Monitoring Preferences” on page 3-42.

❏ Open the printer driver, click the Utility tab, then click the 
EPSON Status Monitor 3 button.
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When you access EPSON Status Monitor 3, the following window 
is displayed.

Viewing information in EPSON Status Monitor 3

EPSON Status Monitor 3 provides the following information:

❏ Current Status
EPSON Status Monitor 3 provides you with detailed printer 
status information, a graphic display of the printer, and status 
messages. If the ink runs low or out, a How to button appears 
in the EPSON Status Monitor 3 window. Click the How to 
button to display cartridge replacement instructions and to 
move the print head to the cartridge replacement position.

❏ Ink Levels
EPSON Status Monitor 3 provides a graphic display of the 
amount of ink remaining.
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Printer Software Introduction

The printer software that comes with your printer includes a 
printer driver and printer utilities. The printer driver lets you 
choose from a wide variety of settings to get the best results from 
your printer. The printer utilities help you check the printer and 
keep it in top operating condition.

For information on using the printer driver, see “Making Changes 
to Printer Settings” on page 5-2.

For information on using the printer utilities, see “Using the 
Printer Utilities” on page 5-32.

You can also get more information about the printer software by 
clicking the help icon in any of the dialog boxes in the printer 
driver.

Making Changes to Printer Settings

You will find the printer driver settings in the following dialog 
boxes.

❏ Print dialog box (click Print on the File menu of your 
application or click Options in the Page Setup dialog box)

❏ Background Printing dialog box (click the  Background 
Printing icon button located in the Print dialog box)

❏ Page Setup dialog box (click Page Setup on the File menu of 
your application)

❏ Layout dialog box (click the  Layout icon button in the Print 
dialog box)

❏ Preview dialog box (click the  Preview icon button in the 
Print dialog box and then click Preview)
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The Mode settings in the Print dialog box are arranged to give you 
three levels of control over the printer driver.

The Mode settings are explained below.

In addition to making comprehensive Mode settings that affect 
overall print quality, you can also modify individual aspects of 
your printout using the settings contained in the Page Setup and 
the Layout dialog boxes. For information on making page setup 
settings, see “Making the Page Setup settings” on page 5-12. For 
information on making page layout settings, see “Modifying the 
Page Layout” on page 5-22.

Making the Media Type setting

The Media Type setting determines what other settings are 
available, so you should always make this setting first.

Automatic This mode provides the quickest and 
easiest way to start printing. See “Using 
the Automatic mode” on page 5-7 for 
details. 

PhotoEnhance This mode lets you choose from a variety 
of image-correction settings specially 
designed for photos. See “Using the 
PhotoEnhance mode” on page 5-7. 

Custom This mode lets you choose from a list of 
ready-made or personalized settings 
suited to the kind of document that you 
want to print. When Custom is selected, 
the Advanced button is enabled, 
allowing you to access the Advanced 
dialog box. See “Using the Custom 
mode” on page 5-9. 
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In the Print dialog box, select the Media Type setting that matches 
the paper that is loaded in the printer. To find out what Media 
Type you are using, find your media in the list below “Media 
types” on page 11-4, and refer to the corresponding media type 
under which it is grouped (shown in larger type). For some types 
of media, there are several Media Type settings to choose from.

Plain Paper

360 dpi Ink Jet Paper

Plain paper

Envelopes

EPSON Premium Ink Jet Plain Paper (A4) S041214

EPSON 360 dpi Ink Jet Paper (A4) S041059
S041025

EPSON 360 dpi Ink Jet Paper (Letter) S041060
S041028

EPSON Iron-On Cool Peel Transfer Paper (A4) S041154

EPSON Iron-On Cool Peel Transfer Paper (Letter) S041153
S041155
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Photo Quality Ink Jet Paper

Matte Paper-Heavyweight

EPSON Photo Quality Ink Jet Paper (A4) S041061
S041026

EPSON Photo Quality Ink Jet Paper (Letter) S041062
S041029

EPSON Photo Quality Ink Jet Paper (Legal) S041067
S041048

EPSON Photo Quality Ink Jet Cards (A6) S041054

EPSON Photo Quality Ink Jet Cards (5 × 8”) S041121

EPSON Photo Quality Ink Jet Cards (8 × 10”) S041122

EPSON Photo Quality Self Adhesive Sheets (A4) S041106

EPSON Ink Jet Note Cards A6 (with envelopes) S041147

EPSON Ink Jet Greeting Cards 5 × 8” 
(with envelopes)

S041148

EPSON Ink Jet Greeting Cards 8 × 10” 
(with envelopes)

S041149

EPSON Matte Paper-Heavyweight (A4) S041256
S041258
S041259

EPSON Matte Paper-Heavyweight (Letter) S041257
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Photo Paper

Photo Quality Glossy Film

Ink Jet Transparencies

Premium Glossy Photo Paper

Note:
The availability of special media varies by location.

EPSON Photo Paper (A4) S041140

EPSON Photo Paper (Letter) S041141

EPSON Photo Paper (4 × 6”) S041134

EPSON Photo Paper (100 × 150 mm) S041255

EPSON Photo Paper (200 × 300 mm) S041254

EPSON Panoramic Photo Paper (210 × 594 mm) S041145

EPSON Photo Paper Cards (A4) S041177

EPSON Photo Quality Glossy Film (A4) S041071

EPSON Photo Quality Glossy Film (Letter) S041072

EPSON Photo Quality Glossy Film (A6) S041107

EPSON Photo Stickers 16 (A6) S041144

EPSON Photo Stickers 4 (A6) S041176

EPSON Ink Jet Transparencies (A4) S041063

EPSON Ink Jet Transparencies (Letter) S041064

EPSON Premium Glossy Photo Paper (A4) S041287
S041297

EPSON Premium Glossy Photo Paper (Letter) S041286
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Using the Automatic mode

When Automatic is selected as the Mode setting in the Print 
dialog box, the printer driver takes care of all detailed settings 
based on the current Media Type and Ink settings. To make the 
Ink setting, click Color to print in color, or Black to print in black-
and-white or grayscale. To make the Media Type setting, see 
“Making the Media Type setting” on page 5-3.

Note:
Depending on the media that you select in the Media Type list (while 
Automatic is selected), a slider appears to the right of the Mode options 
that lets you choose Quality or Speed. Select Quality when print 
quality is more important than speed.

Using the PhotoEnhance mode

The Photo Enhance mode provides a variety of image-correction 
settings that you can apply to your photos before printing. 
PhotoEnhance does not affect your original data.
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Note:
❏ This mode is only available when printing 16-, 24-, or 32-bit color 

data.

❏ Printing with PhotoEnhance selected may increase the time required 
for printing, depending on your computer system and the amount 
of data contained in your image.

You can select from the following settings.

If you are printing photos taken with a digital camera, you can 
also select the Digital Camera Correction check box to give your 
printed images the smooth, natural appearance of photographs 
taken with a film camera.

Standard This setting provides standard image correction for 
most photos. Try this first.

People This setting is best for photos of people.

Nature This setting is best for outdoor scenery such as 
mountains, sky, and oceans.

Soft Focus This setting makes your photos look as if they were 
taken with a soft-focus lens.

Sepia This setting applies a sepia tone to your photos.
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Using the Custom mode

The Custom mode offers ready-made settings designed for 
printing text and graphs and for applying a color-matching 
method. You can also create and save your own custom settings. 
Refer to the appropriate section below.

You can select from the following ready-made settings.

When you select a Custom setting, other settings such as Print 
Quality, Halftoning, and Color Management are made 
automatically. Changes to these settings are reflected in the 
display at the left side of the Print dialog box. 

Follow the steps below to select a Custom setting.

1. Confirm that the Media Type and Ink settings in the Print 
dialog box are correct. For details, see “Making the Media 
Type setting” on page 5-3.

2. Select Custom as the Mode setting in the Print dialog box. 
This enables the Custom Settings list, located to the right of 
the Custom radio button.

Text/Graph This setting is good for printing 
presentation documents such as graphs 
and charts.

Economy This setting is best for printing drafts of text.

ColorSync This setting automatically adjusts printout 
colors to match colors on your screen.
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3. From the Custom Settings list, select the most appropriate 
setting for the type of document or image that you will print.

Making the Advanced settings
The settings in the Advanced dialog box give you complete 
control over your printing environment. Use these settings to 
experiment with new printing ideas, or to fine-tune a range of 
print settings to meet your individual needs. Once you are 
satisfied with your new settings, you can give them a name and 
add them to the Custom Settings list.

Follow the instructions below to make Advanced settings.

1. Select Custom as the Mode setting in the Print dialog box, 
then click the Advanced button. The Advanced dialog box 
opens.

2. Select the Media Type that is loaded in the printer. For details, 
see “Making the Media Type setting” on page 5-3.

3. Choose Color or Black as the Ink setting.

4. Select the Print Quality setting.

5. Make other settings as necessary. For details, see online help.
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Note:
❏ The PhotoEnhance feature only affects images, not text or 

graphs. For example, if Monochrome is selected in the Tone 
list (enabled when PhotoEnhance is selected as the Color 
Management setting), only the images in a document will be 
printed in monochrome. Any colored text or graphs in the same 
document will be printed in color.

❏ Some settings may be unavailable depending on the Print 
Quality, Media Type, and Ink settings that you make.

6. Click OK to apply your settings and return to the Print dialog 
box. Click Cancel to return to the Print dialog box without 
applying your settings. To save your Advanced settings, see 
the next section.

Saving and deleting your Advanced settings
To save your Advanced settings in the Custom Settings list, click 
Save Settings in the Advanced dialog box. The Custom Settings 
dialog box appears.

Type a unique name (up to 16 characters) for your settings in the 
Name box, then click Save. Your Advanced settings will be added 
to the Custom Settings list. You can save up to 10 different custom 
settings. 

Note:
❏ You cannot apply the names of EPSON ready-made settings to your 

custom settings.
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❏ You cannot delete the ready-made settings from the Custom Settings 
list.

To delete a setting from the Custom Settings list, select it in the 
Custom Settings dialog box and click Delete.

Using your saved settings
To use your saved settings, select Custom as the Mode setting in 
the Print dialog box, then select your setting in the Custom 
Settings list, located to the right of the Custom radio button.

If you change the Media Type or Ink settings while one of your 
customized settings is selected in the Custom Settings list, the 
selection shown in the list returns to Custom Settings. The 
customized setting that was previously selected is not affected by 
the change. To return to your customized setting, simply reselect 
it in the list.

Making the Page Setup settings

In the Page Setup dialog box, you can change the paper size, 
specify the paper orientation, choose to print on both sides of the 
paper, reduce or enlarge your printout, and adjust the printable 
area.

To open the Page Setup dialog box, select Page Setup from the 
File menu of your application. The following dialog box appears.
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You can make the following settings in the Page Setup dialog box.

Defining a custom paper size
If the appropriate paper size is not included in the Paper Size list 
in the Page Setup dialog box, follow the steps below to define a 
custom paper size.

Paper Size Select the paper size that you want to use. If you 
want to define a custom paper size, see “Defining 
a custom paper size” on page 5-13.

Orientation Select Portrait (tall) or Landscape (wide) to change 
the orientation of your printout. If you need to print 
close to the bottom of the page, select the Rotate 
by 180 degrees check box.

Double-Sided 
Printing

Select the Double-Sided check box to print on both 
sides of the paper. Select the Folded Booklet check 
box to make single-fold booklets. For details, see 
“Printing on both sides of the paper” on page 5-15.

Reduce or 
Enlarge

Use this setting to reduce or enlarge the size of your 
image, from 25% to 400%.

Printable Area Select Centered to center the printout. Select 
Maximum to increase the printable area.

Note:
When Maximum is selected, the print quality may 
decline at the edges of the printout. Before printing 
large jobs using this setting, print a single sheet to 
confirm quality.
When Maximum is selected, make sure that the 
paper loaded in the sheet feeder is not curled.
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1. In the Page Setup dialog box, click Customize. The following 
dialog box appears.

2. Click New. The dialog box updates to allow you to enter a 
name for the new size.

3. Type a unique name for the paper size in the paper size list.

4. Specify the measurement unit as either inch or cm.

5. Enter the width and the height of your paper.
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6. Specify the margins in the Margin text boxes or by dragging 
the cursor on the preview image.

7. Click OK to return to the Page Setup dialog box.

You can define up to 100 paper sizes. The paper size names that 
you create will appear in the Paper Size list in the Page Setup 
dialog box.

To delete a custom paper size, click Customize in the Page Setup 
dialog box, select the paper size that you wish to delete from the 
list in the Custom Paper dialog box, and click Delete.

Copying a paper size
Follow the steps below to copy a paper size and use it as a template 
for a new paper size.

1. Select an existing paper size that you wish to copy, and click 
Copy.

2. Specify the measurement unit as either inch or cm.

3. Specify the margins in the Margin text boxes or by dragging 
the cursor on the preview image.

4. Click OK to return to the Page Setup dialog box.

Printing on both sides of the paper
The EPSON Stylus COLOR 980 allows double-sided printing. 
There are two types of double-sided printing available. Standard 
double-sided printing allows you to print the odd-numbered 
pages first. Once these are printed, you can reload the printouts 
in the sheet feeder and print the even-numbered pages on the 
other side of the paper. Folded Booklet double-sided printing 
allows you to make single-fold booklets. Refer to the appropriate 
section below.
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Note:
❏ You can load up to 30 sheets of paper at one time when double-sided 

printing; however, the loading capacity of the sheet feeder varies, 
depending on the media type.

❏ Only use media types which are suitable for double-sided printing. 
Otherwise, the printout quality may deteriorate.

❏ Depending on the type of paper and the amount of ink used to print 
text and images, ink may bleed through to the other side of the paper.

Standard double-sided printing

Follow the steps below to print first the odd-numbered pages, and 
then the even-numbered pages after you have reloaded the 
printouts.

1. Select the Double-Sided Printing check box in the Page Setup 
dialog box. For information on accessing the Page Setup 
dialog box, see “Making Changes to Printer Settings” on page 
5-2.
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2. Click the Margins button. The following dialog box opens

3. Specify which edge of the paper the binding will be on. You 
can choose between Left, Top, and Right.

4. Specify the width of the binding margin by entering a value 
in the Binding Margin text box. You can specify a value 
between 3 mm and 30 mm.

Note:
The actual binding margin may vary, depending on your 
application. Experiment by printing a few sheets using different 
binding margin values before printing the entire job; otherwise, the 
results may differ from what you expect.

5. Click OK to return to the Page Setup dialog box, then click OK 
to save your settings.

6. Load paper in the sheet feeder, then send the print job from 
your application. While the printer is printing the odd-
numbered pages, instructions are displayed which explain 
how to reload the paper correctly.

7. Follow the instructions to reload the paper, or reload the 
paper as shown in the illustration below.

Note:
❏ The paper may curl during printing, depending on the amount 

of ink used to print text and images. Flatten it or curl it slightly 
toward the opposite side before printing on the other side of the 
paper.
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❏ Tap the stack of paper on a flat surface to align the edges before 
reloading it.

❏ Reload the printouts as instructed; otherwise, the paper may 
jam or the binding margin may differ from what you expect.

❏ If the paper jams, see “Paper Does Not Feed Correctly” on page 
10-23.

8. Once the paper is reloaded, click Resume to print the even-
numbered pages.
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Folded Booklet double-sided printing

You can also make single-fold booklets using the double-sided 
printing feature. When booklet printing, the printer first prints 
the pages which will be on the outside after you fold the paper, 
and then prints the inside pages after you reload the paper, as 
shown in the illustration below.

In this example, the printer would print pages 1 and 4 of your 
document on the first sheet of paper, pages 5 and 8 on the second 
sheet of paper, and pages 9 and 12 on the third sheet of paper. 
After you reload the printouts in the sheet feeder, the printer 
would then print pages 2 and 3 on the back of the first sheet of 
paper, pages 6 and 7 on the back of the second sheet of paper, and 
10 and 11 on the back of the third sheet of paper. After printing is 
finished, you can fold each sheet of paper and bind them together.

Follow the steps below to print booklets.

1. Select the Double-Sided Printing check box in the Page Setup 
dialog box, then select the Folded Booklet check box.

2. Click the Margins button. The Margins dialog box opens.

Single-fold booklet

Binding Edge

1

2 4

3 5 9

6

7

8 10

11

12
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3. Specify which edge of the paper the binding will be on. You 
can choose between Left, Top, and Right.

Note:
While Portrait is selected as the Orientation setting in the printer 
driver, you can choose between Left and Right. While Landscape 
is selected, you can only select Top.

4. Specify the width of the binding margin by entering a value 
in the Binding Margin text box. You can specify a value 
between 3 mm and 30 mm. This margin width will be inserted 
on both sides of the fold. For example, if you specify a value 
of 10 mm, a 20-mm margin will be inserted, with 10 mm on 
each side of the fold.

5. Click OK to return to the Page Setup dialog box, then click OK 
to save your settings. 

6. Load paper in the sheet feeder, then send the print job from 
your application.

 Margin

Folding 
Edge

Portrate  Landscape
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7. While the printer is printing the outside pages, instructions 
are displayed which explain how to reload the paper 
correctly. Follow the on-screen instructions to reload the 
paper, or reload the paper as shown in the illustration in the 
previous section, “Standard double-sided printing” on page 
5-16.

Note:
❏ The paper may curl during printing, depending on the amount 

of ink used to print text and images. Flatten it or curl it slightly 
toward the opposite side before printing on the other side of the 
paper.

❏ Tap the stack of paper on a flat surface to align the edges before 
reloading it.

❏ Reload the printouts as instructed; otherwise, the paper may 
jam or the binding margin may differ from what you expect.

❏ If the paper jams, see “Paper Does Not Feed Correctly” on page 
10-23.

8. Once the paper is reloaded, click Resume to print the inside 
pages. 

9. Once printing is complete, fold the printouts properly and 
bind them together using a stapler or other binding method.
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Modifying the Page Layout

You can modify the page layout of your document using the 
settings found in the Layout dialog box. To open this dialog box, 
click Print on the File menu of your application, then click the  
Layout icon button in the Print dialog box. The Layout dialog box 
appears.

The Layout dialog box allows you to automatically match the 
document size to the paper size, place watermarks on documents, 
print two or four pages on a single sheet of paper, print poster-
size images by enlarging one page to cover several sheets, or set 
the order in which you would like the pages of your document to 
print.

You can also specify the printing order for your print job. When 
printing multiple copies of your document, select Collate to print 
one complete document set at a time. Select Reverse Order to 
print your document in reverse order, starting with the last page.
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Fitting your document to the paper size

You can proportionally enlarge or reduce the size of the image to 
make it fit a specified paper size. To do this, load paper of the 
correct size, select the Fit to Page check box, then specify the 
appropriate paper size in the Paper Size list.

Printing two or four pages on one sheet

To print two or four pages of your document on one sheet of 
paper, select the Multi-Page check box in the Page Layout dialog 
box, then click N-up.

You can choose from the following settings. 

2 Pages
4 Pages

Prints two or four pages of your document on 
a single piece of paper.

Page Order Allows you to specify the order in which the 
pages will be printed on the sheet of paper.

Print page 
frames

Allows you to print a frame around each page 
on the sheet of paper.
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Printing posters

A single document page can be enlarged to cover 4, 9, or 16 
printed sheets of paper. To print a poster-size image, select the 
Multi-Page check box in the Page Layout dialog box, then click 
Poster.

You can make the following settings.

If you only want to print a few of the panels without printing the 
entire poster, click Panel Selection, then click the panels that you 
do not wish to print, and then click OK. Only the panels that you 
did not click will be printed.

1 page covers xx sheets Specifies how many printed sheets of paper 
the enlarged document page is to cover. 
You can select 4, 9, or 16 pages.

Print Cutting Guidelines Prints border lines on the images to guide 
you when trimming the pages.

Overlapping Panels Slightly overlaps the images so that they can 
be aligned more precisely.
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Printing a watermark on your document

To print a watermark in the background of your document, select 
the Watermark check box in the Page Layout dialog box.

Select the watermark that you wish to print from the Name list, 
then specify its position, size, color, and intensity. You can change 
the position and size of the watermark by dragging it with your 
mouse in the preview window at the left side of the dialog box.

You can also add your own text-based or image-based 
watermarks to the Name list. Follow the steps below.
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1. Click the Add/Del button beside the Name list. The following 
dialog box appears.

2. To use an image file as a watermark, click the Add PICT 
button. Specify the desired image file, then click Open. 

To create a text-based watermark, click the Add Text button. 
Type the text in the Text box, select a font and a text style, then 
click OK.
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3. The image file name or the watermark text appears in the 
Mark Name list in the Watermark dialog box. To change the 
name of an image watermark, select it in the list, then type a 
new name. When a text watermark is selected in the Name 
list, you can edit the text and change the font and text style by 
clicking the Edit Text button.

4. Click OK to add your watermark to the Name list in the Page 
Layout dialog box.

Making the Print Time setting

You can specify the priority of a printout or set the time that you 
want the printer to begin printing your document. Follow the 
steps below.

1. Click the  Background Printing icon button in the Print 
dialog box. The Background Printing dialog box opens.
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2. Select On as the Background Printing setting.

3. Select Urgent, Normal, Print at, or Hold as the Print Time 
setting.

If you select Print at, use the arrows beside the date and time 
boxes to specify the date and time that you want the document 
to be printed.

Note:
Make sure that the computer and printer are turned on at the date 
and time specified.

4. Click OK. The Background Printing dialog box closes.

5. In the Print dialog box, make sure that your print settings are 
as you want them, then click Print.

Note:
You can check or change the priority of print jobs using the EPSON 
Monitor3 utility. See “Using EPSON Monitor3” on page 6-4 for details.

Saving spool data as a file

You can save the spool data as a file by using the Save File feature 
in the Print dialog box. This feature lets you print the file at a later 
time using the saved spool data, simply by double-clicking the 
saved file. Follow the steps below to save spool data for files and 
to print files using saved spool data.

1. Make your printer driver settings.

2. Click the  Preview icon button in the Print dialog box 
repeatedly until the Print button changes into the Save File 
button.
5-28      Using the Printer Software for Macintosh



3. Click the Save File button. The following dialog box appears.

4. Browse for the location where you want to save the file, then 
type a file name in the Save As text box and click Save. The 
print settings are now saved for this file.

5. When you want to print the document, double-click the file 
to open EPSON Monitor 3, make sure that the correct 
document is selected, then click the  Resume button to send 
the data to the printer.

Previewing your printout

The Preview feature allows you to see how your document will 
look before actually printing it. Follow the steps below to preview 
your document.

1. Make your printer driver settings.

2. Click the Preview icon button in the Print dialog box. The 
Print button changes into a Preview button. 

Note:
Click the Preview icon button to toggle between the Print, 

Preview, and Save File modes. For information on the Save 
File mode, see “Saving spool data as a file” on page 5-28.
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3. Click the Preview button. The Preview dialog box appears 
and displays a preview of your document.

The Preview dialog box contains six icon buttons that you can 
use to perform the following functions.

Selection Click this button to select, move, and 
resize watermarks.

Zoom Click this button to enlarge or reduce 
the size of the previewed page.

Show/hide 
printable 
area

Click this button to display or hide 
borderlines which indicate the 
printable area.

Watermark 
editing

Click this button to open the 
Watermark Edit box, where you can 
add watermarks to the document 
and change any of the current 
watermark settings.

Add page Click these buttons to add or remove 
the highlighted pages from the list of 
pages to be printed.

Remove 
page
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Note:
❏ When using the double-sided printing feature, the Preview 

window allows you to toggle between pages in the print job by 
clicking the appropriate page in the list at the left side of the 
screen. The pages are listed in two columns, Front and Back. 
The pages in the Front column will print first. The page 
numbers listed refer to pages of the print job, and may contain 
more than one document page.

❏ If it is necessary to reprint part of a double-sided print job, select 
each page of the print job that does not need to be reprinted in 
the list at the left side of the screen, then click the remove 
page button. Make sure that the paper is loaded properly so that 
the print job will start on the correct side of the correct page.

4. If you are satisfied with the previewed image, click Print.

If you are not satisfied with the appearance of the image, click 
Cancel. The Preview and Print dialog boxes close with the 
current print settings preserved. Open the Print dialog box 
again to make additional changes to the print settings.
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Using the Printer Utilities

EPSON printer utilities allow you to check the current printer 
status and to perform some printer maintenance from your 
computer screen. To access the utilities, click the  Utility icon 
button in the Print or Page Setup dialog box, then click the button 
for the utility that you want to use.

The printer utilities are described below.

EPSON StatusMonitor

The StatusMonitor utility monitors the printer status. If it detects 
a printer error, it will inform you with an error message.

You can also use this utility to check how much ink is remaining 
before printing.

To use the StatusMonitor, click the EPSON StatusMonitor button 
in the Utility dialog box. For details, see “Using EPSON 
StatusMonitor” on page 6-1.
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Note:
Do not use the Nozzle Check, Head Cleaning, or Print Head Alignment 
utilities while printing is in progress; otherwise, your printout may be 
marred.

Nozzle Check

The Nozzle Check utility checks the print head nozzles for 
clogging. Check the nozzles if you notice print quality has 
declined and after cleaning to confirm that the print head nozzles 
have been cleaned. If the nozzle check indicates that the print head 
needs cleaning, you can access the Head Cleaning utility directly 
from the Nozzle Check utility. For details, see “Checking the Print 
Head Nozzles” on page 9-1.

Head Cleaning

The Head Cleaning utility cleans the print head. You may need 
to clean the print head when you notice print quality has declined. 
Use the Nozzle Check utility first to confirm that the print head 
needs to be cleaned. For details, see “Cleaning the Print Head” on 
page 9-4.

Print Head Alignment

The Print Head Alignment utility aligns the print head. Use this 
utility if you notice a misalignment of vertical or horizontal lines.

Configuration

The Configuration dialog box allows you to change the way that 
the StatusMonitor utility notifies you when the printer status 
changes. For details, see “Using the Configuration Settings dialog 
box” on page 6-2.
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Using EPSON StatusMonitor

EPSON StatusMonitor is a utility that monitors the printer. If it 
detects a printer error, it will inform you with an error message.

You can also use this utility to check ink levels before printing. 
When open, EPSON StatusMonitor displays the amount of ink 
remaining at the time it was opened. To update the ink level 
information, click the Update button.

Accessing EPSON StatusMonitor

To access EPSON StatusMonitor, follow the steps below.

1. Click Print or Page Setup on the File menu of your 
application. The Print dialog box appears.
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2. Click the  StatusMonitor icon button. Or, click the  
Utility icon button, then click the EPSON StatusMonitor 
button in the Utility dialog box that appears. The 
StatusMonitor dialog box opens.

Using the Configuration Settings dialog box

If you want to change the way that the StatusMonitor utility 
monitors your printer, or change the way that your printer 
handles print jobs, follow the steps below.

1. Click Print or Page Setup on the File menu of your 
application.

2. Click the  Utility icon button.
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3. Click the Configuration button. The Configuration Settings 
dialog box opens.

In the Configuration Settings dialog box, you can make the 
following settings:

Error notification Choose the method by which EPSON 
StatusMonitor will notify you in case of an 
error.

Warning Choose the method by which EPSON 
StatusMonitor will notify you if a warning 
message becomes necessary.

Temporary Spool 
folder

Specify the folder in which print data will 
be temporarily spooled.

Temporary High Speed 
Copies folder

Specify the folder in which multiple-copy 
print data will be temporarily stored.

Data will be sent to the 
printer after being 
stored on your disk.

Select this check box to prevent horizontal 
banding in printouts that contain images 
by having the computer temporarily store 
image data on its hard drive. The 
computer will then send the image data 
to the printer as a whole rather than as 
rectangular bands.

Check for errors before 
starting to print.

Select this check box to have the printer 
check for errors before starting to print.
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Using EPSON Monitor3

After you send a print job to the printer, the EPSON Monitor3 
utility allows you to check, cancel, or change the priority of print 
jobs that are queued for printing. This utility also shows the status 
of the job that is currently being printed.

Accessing EPSON Monitor3

To access EPSON Monitor3, follow the steps below.

1. Turn on Background Printing in the Chooser or in the 
Background Printing dialog box.

2. Send a print job to the printer.

3. Select EPSON Monitor3 from the Application menu at the 
right end of the menu bar. The EPSON Monitor3 dialog box 
opens.

Check the ink level 
before starting to print.

Select this check box to have the printer 
check the ink levels before starting to 
print.
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Note:
You can also open EPSON Monitor3 by double-clicking the EPSON 
Monitor3 icon in the Extensions folder.

Managing print jobs using EPSON Monitor3

Using EPSON Monitor3, you can manage print jobs as described 
below:

❏ Use the buttons below to hold, resume, and delete print jobs. 
Select the print job that you wish to manage, then click the 
appropriate button.

❏ Click Stop Print Queue to stop printing. Click Start Print 
Queue to resume printing.

Hold Pauses printing and keeps the current 
print job at the top of the print queue

Resume Resumes printing

Delete Stops printing and deletes the print job 
from the print queue
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❏ Use the buttons below to start the printer utilities.

❏ Double-click a file in the list to preview it.

Note:
This function is not available when you are printing the ESC/P 
command file.

❏ Double-click Copies to change the number of copies of the 
selected print job that will be printed.

❏ Click the Show details arrow to open an extension at the 
bottom of the EPSON Monitor3 dialog box, similar to the one 
below. The extension displays detailed information on the 
selected document’s printer driver settings.

Print head 
cleaning

Starts the Print Head Cleaning utility

StatusMonitor Starts the EPSON StatusMonitor, which 
displays the amount of ink remaining
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Changing the priority of print jobs

To change the priority of print jobs in a print queue, follow the 
steps in this section.

Note:
You can also change the priority of print jobs whose print times were 
previously set in the printer driver’s Background Printing dialog box.

1. In the Document Name column, select the print job for which 
you wish to change the priority.

2. Click the Show details arrow to open an extension at the 
bottom of the EPSON Monitor3 dialog box, similar to the one 
below.

3. From the Priority list, select Urgent, Normal, Hold, or Print 
Time.
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Note:
If you select Print Time, a dialog box opens where you can specify 
the date and time that the document will print. Make sure that your 
printer and computer are turned on at the specified time.
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Network Printing for Windows 98 and 95 Users

This section tells you how to set up your printer so that other 
computers on a network can use it.

First, you need to set up the printer as a shared printer on the 
computer to which the printer is connected. Then, you must 
specify the network path to the printer from each computer that 
will use it and install the printer software on those computers.

Note:
This section describes how to use your printer as a shared printer on a 
network. To connect your printer directly to a network without setting 
it up as a shared printer, consult your network administrator.
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Setting up your printer as a shared printer

To share a printer with other computers on a network, follow the 
steps below to configure the computer to which the printer is 
connected.

1. Click Start, point to Settings, then click Control Panel.

2. Double-click the Network icon.

3. Click the File and Print Sharing button.

4. Select the I want to be able to allow others to print to my 
printer(s) check box and click OK.

5. In the Network dialog box, click OK. You return to the Control 
Panel.

6. Double-click the Printers icon.

Note:
❏ If a dialog box requesting the insertion of the Windows 98 or 95 

CD-ROM appears, insert the CD in the CD-ROM drive and 
follow the on-screen instructions.

❏ If a dialog box requesting that you to restart your computer 
appears, do so. Then, open the Printers folder and continue from 
step 7.
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7. Select the icon for your printer and click Sharing on the File 
menu.

8. Select Shared As, then enter the printer information as 
required and click OK.

Accessing the printer through a network

To access your printer from other computers on a network, follow 
the steps below for each computer that will access the printer.

Note:
Your printer must be set up as a shared resource on the computer to 
which it is directly connected before you can access it from another 
computer. For instructions, see “Setting up your printer as a shared 
printer” on page 7-2.

1. Click Start, point to Settings, and click Printers.

2. Double-click the Add Printer icon. The Add Printer Wizard 
opens.
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3. Click Next.

4. Select Network printer, then click Next.

5. Click Browse.

6. Double-click the icon of the computer that is directly 
connected to the printer. Then click the icon of the appropriate 
printer.

7. Click OK and follow the on-screen instructions.
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Network Printing for Windows 2000 and NT 4.0 
Users

This section tells you how to set up your printer so that other 
computers on a network can use it.

Note:
❏ This section is written for small network users only. If you are on a 

large network and would like to share your printer, consult your 
network administrator.

❏ The screens shown in this section are from Windows NT 4.0.

First, you need to set up the printer as a shared printer on the 
computer to which the printer is connected. Then, you must 
specify the network path to the printer from each computer that 
will use it and install the printer software on those computers.

Setting up your printer as a shared printer

To share a printer with other computers on a network, follow the 
steps below to configure the computer to which the printer is 
connected.

1. Click Start, point to Settings, and click Printers.

2. Select the icon for your printer, then click Sharing on the File 
menu.
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3. Select Shared (for Windows 2000 users, select Shared as:), 
then enter the Share Name.

4. Click OK.

Note:
❏ Do not select a driver from the Alternate Drivers list.

❏ For Windows 2000 users, do not select a driver from Additional 
Drivers list in the Additional Drivers dialog box.

Accessing the printer through a network

To access your printer from other computers on the network, 
follow the steps in this section for each computer that will access 
the printer.

Note:
Your printer must be set up as a shared resource on the computer to 
which it is directly connected before you can access it from another 
computer. For instructions, see “Setting up your printer as a shared 
printer” on page 7-5.
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1. Install the printer driver from the software CD-ROM.

2. Click Start, point to Settings, and then click Control Panel.

3. Double-click the Printers icon.

4. Right-click the icon for your printer, then click Properties in 
the shortcut menu that appears. The printer driver opens.

5. Click the Ports tab and then Add Port.
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6. In the Printer Ports dialog box, select Local Port and click 
New Port.

7. In the Port Name dialog box, enter the path information for 
your printer using the format below:
\\name of computer that is connected to the 
printer\name of the shared printer

8. Click OK to return to the Printer Ports dialog box.
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9. Click Close to return to the Ports menu.

10. On the Ports menu, make sure that the new port is included 
in the list and that the corresponding check box is selected. 
Click OK to close the printer driver.
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Network Printing for Macintosh Users

This section tells you how to set up the printer so that you can use 
it on an AppleTalk network. By setting up your printer as a shared 
printer, your local printer is connected to the network and can be 
used by other computers.

First, you need to set up the printer as a shared printer on the 
computer to which the printer is connected. Then, you must 
specify the network path to the printer from each computer that 
will use it, and install the printer software on those computers.

Setting up your printer as shared printer

To share a printer with other computers on an AppleTalk 
network, follow the steps below to configure the computer to 
which the printer is connected.

1. Turn on the printer.

2. Choose Chooser from the Apple menu and click the icon for 
your printer. Then select the port to which the printer is 
connected from the Select a printer port list.
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3. Click the Setup button or double-click a printer port. The 
Printer Sharing Setup dialog box appears.

4. Select the Share this Printer check box, then type the printer 
name and password information as required.

5. Click OK. The name of the shared printer appears in the port 
list in the Chooser.

6. Close the Chooser.

Accessing the printer through a network

To access your printer from other computers on a network, follow 
the steps in this section for each computer that will access the 
printer.

1. Turn on your printer.

2. Install the printer driver from your software CD-ROM.

3. Choose Chooser from the Apple menu. Then, click the 
appropriate printer icon and select the printer port that you 
want to use from the Select a printer port list.
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Note:
Only printers that are connected to your current AppleTalk zone 
are available.

4. If the following dialog box appears, enter the password for 
the printer, then click OK.

5. Select the appropriate Background Printing radio button to 
turn background printing on or off.

6. Close the Chooser.
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Replacing an Empty Ink Cartridge

Follow the instructions in this section to replace an ink cartridge 
using the printer’s control panel or the Status Monitor utility.

Using the printer's control panel

The printer’s indicator lights will inform you when it is time to 
obtain a replacement ink cartridge and when it is time to replace 
an empty cartridge.

Note:
If you need to replace an ink cartridge while the B black and A color ink 
out lights are off, see “Replacing an Old or Damaged Ink Cartridge” on 
page 8-8.
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The following table describes the status of the lights on your 
printer and the actions that you need to take.

o = on, f = flashing

w Warning:
❏ Keep ink cartridges out of the reach of children. Do not allow 

children to drink from or otherwise handle the cartridges.

❏ If ink gets on your skin, wash it thoroughly with soap and 
water. If ink gets in your eyes, flush them immediately with 
water. If discomfort or vision problems remain after a 
thorough flushing, see a doctor immediately.

c Caution:
❏ EPSON recommends the use of genuine EPSON ink 

cartridges. Other products not manufactured by EPSON 
may cause damage to your printer not covered by EPSON's 
warranties.

❏ Leave the old cartridge installed in the printer until you have 
obtained a replacement; otherwise, ink remaining in the print 
head nozzles may dry out.

Note:
❏ You cannot continue printing with one ink cartridge empty, even if 

the other cartridge still contains ink. Before printing, replace the 
empty cartridge.

Light Action

f  B Obtain a replacement black ink cartridge (T003).

o  B Replace the empty black ink cartridge.

f  A Obtain a replacement color ink cartridge (T005).

o  A Replace the empty color ink cartridge.
8-2      Replacing Ink Cartridges



       
❏ In addition to the ink used during printing, ink is consumed during 
the print head cleaning operation and during the self-cleaning cycle 
which is performed when the printer is turned on.

To replace an ink cartridge using the printer’s control panel, 
follow the steps below.

Note:
You can also replace an ink cartridge from your computer using the 
Status Monitor. Click the Replace Ink Cartridge button in the 
Status Monitor’s Printer Status window, then follow the on-screen 
instructions.

1. Make sure that the printer is on. The P power light should be 
on, but not flashing. 

2. Determine which cartridge needs to be replaced as indicated 
by the B black and A color ink out lights.

3. Lower the output tray at the front of the printer, then open 
the printer cover.

4. Hold down the R cleaning button for three seconds. The 
print head moves left to the ink cartridge replacement 
position, and the P power light begins flashing.

c Caution:
Do not move the print head by hand as this may damage the 
printer. Always press the R cleaning button to move it.
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Note:
If you press the R cleaning button for three seconds while the 
B black and A color ink out lights are off, the printer will clean the 
print head.

5. Push back the release tabs and lift up the clamp that holds the 
cartridge. The cartridge rises partly out of the cartridge 
holder. 

c Caution:
Do not open the ink cartridge clamp until you are ready to 
replace the ink cartridge. Opening the clamp will cause the 
installed ink cartridge to become unusable, even if ink 
remains.

6. Lift the cartridge out of the printer and dispose of it properly. 
Do not take the used cartridge apart or try to refill it.
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w Warning:
If ink gets on your skin, wash it thoroughly with soap and 
water. If ink gets in your eyes, flush them immediately with 
water.

7. Remove the new ink cartridge from its protective bag. Next, 
remove only the yellow tape seal from the cartridge.

c Caution:
❏ You must remove the yellow tape seal from the cartridge 

before installing it; otherwise, the cartridge will become 
unusable and you will be unable to print.

❏ Do not remove the blue portion of the tape seal from the 
top of the cartridge; otherwise, the print head may 
become clogged and will be unable to print.

❏ Do not remove the tape seal from the bottom of the 
cartridge; otherwise, ink will leak.

black ink cartridge (T003) color ink cartridge (T005)
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8. Place the ink cartridge gently in the cartridge holder with the 
label on the cartridge facing up. Do not press down on the 
cartridge. Lower the ink cartridge clamp until it locks into 
place.

9. Lower the ink cartridge clamp until it locks into place.

c Caution:
Once you install the ink cartridges, do not open their clamps 
again until you replace the cartridges. Otherwise, the 
cartridges may become unusable.

10. If you need to replace the color ink cartridge as well, press the 
R cleaning button. Then repeat steps 4 through 8.
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11. Make sure that the B black and A color ink out lights are off, 
then press the R cleaning button. The printer moves the 
print head and begins charging the ink delivery system. This 
process takes about one minute to complete. When the ink 
charging process is finished, the printer returns the print head 
to its home position and the P power light stops flashing and 
stays on.

c Caution:
The P power light continues to flash while the printer 
performs the ink charging operation. Never turn off the 
printer while this light is flashing. Doing so can result in 
incomplete charging of ink.

12. Close the printer cover.

Using the Status Monitor utility

You can monitor the remaining ink levels from your computer 
and view on-screen instructions for replacing a low or empty ink 
cartridge using the Status Monitor utility.

When an ink cartridge is low or empty, click the How to button 
in the EPSON Status Monitor window. The print head moves to 
the ink cartridge replacement position. Follow the on-screen 
instructions to replace the cartridge.
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For more information on using EPSON Status Monitor, see 
“Using EPSON Status Monitor 3” on page 4-4 (Windows) or 
“Using EPSON StatusMonitor” on page 6-1 (Macintosh).

Replacing an Old or Damaged Ink Cartridge

In some circumstances, you may need to replace an ink cartridge 
before it is empty. For example, if the quality of your printouts 
remains poor even after repeatedly cleaning and aligning the 
print head, one or both of the ink cartridges may be old or 
damaged and should be replaced.

If the B black or A color ink out light is flashing or is on, replace 
the empty ink cartridge as described in “Replacing an Empty Ink 
Cartridge” on page 8-1.

To replace an ink cartridge before the B black or A color ink out 
light flashes, follow the instructions in this section.

c Caution:
❏ Once you remove an ink cartridge from the printer, it 

becomes unusable and cannot be reinstalled, even if ink 
remains.

❏ Leave the old cartridge installed in the printer until you are 
ready to replace it with a new one.

1. Make sure that the printer is on. The P power light should be 
on, but not flashing.

2. Lower the output tray; then open the printer cover.
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3. Hold down the E load/eject button for three seconds. The 
print head moves to the black cartridge replacement position 
and the P power light begins flashing.

If you need to replace only the color ink cartridge, press the 
E load/eject button to move the print head to the color 
cartridge replacement position.

4. Lift the ink cartridge clamp. Then, lift the ink cartridge out of 
the printer and dispose of it properly.

5. Remove the yellow tape seal from the new cartridge.
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c Caution:
❏ You must remove the yellow tape seal from the cartridge 

before installing it; otherwise, the cartridge will become 
unusable.

❏ Do not remove the blue portion of the tape seal from the 
top of the cartridge; otherwise, the print head may 
become clogged and be unable to print.

❏ Do not remove the tape seal from the bottom of the 
cartridge; otherwise, ink will leak.

6. Place the cartridge gently in the cartridge holder. Do not press 
down on the cartridge. Lower the ink cartridge clamp until it 
locks into place.

c Caution:
Once you install the cartridges, do not open their clamps 
again until you replace the ink cartridges. Otherwise, the 
cartridges may become unusable.

7. Press the E load/eject button. The print head moves to the 
color cartridge replacement position. If you need to replace 
the color ink cartridge as well, repeat steps 5 through 7.

8. Press the E load/eject button again. The printer moves the 
print head back to its home position and charges ink in the 
system. This process takes about one minute to complete.
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c Caution:
The P power light continues to flash while the printer 
performs the ink charging operation. Never turn off the 
printer while the P power light is flashing. Doing so can 
result in incomplete charging of ink.

9. Close the printer cover.
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Checking the Print Head Nozzles

If you find that the printed image is unexpectedly faint or that 
dots in the printed image are missing, you may be able to identify 
the problem by checking the print head nozzles.

You can check the print head nozzles from your computer using 
the Nozzle Check utility in the printer software, or from the 
printer using the printer’s control panel buttons.

Using the Nozzle Check utility

To use the Nozzle Check utility, refer to the appropriate section 
below.
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Note:
Do not use the Nozzle Check utility while printing is in progress; 
otherwise, your printout may be marred.

For Windows users
Follow the steps below to use the Nozzle Check utility.

1. Make sure that A4 or Letter size paper is loaded in the sheet 
feeder.

2. Access the printer software. If you need instructions, see 
“Accessing the printer software” on page 3-2.

3. Click the Utility tab, then click the Nozzle Check button.

4. Follow the on-screen instructions.

For Macintosh users
Follow the steps below to use the Nozzle Check utility.

1. Make sure that A4 or Letter size paper is loaded in the sheet 
feeder.

2. Access the Print or Page Setup dialog box.

3. Click the  Utility icon button, then click the Nozzle Check 
button.

4. Follow the on-screen instructions.

Using the control panel buttons

Follow the steps below to check the print head nozzles using the 
control panel buttons.

1. Turn off your printer.
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2. Make sure that A4 or Letter size paper is loaded in the sheet 
feeder.

3. Hold down the E load/eject button (➀ in the illustration 
below) and press the P power button (➁ in the illustration 
below) to turn on the printer.

4.  Release both buttons.
Maintenance      9-3



The printer prints an operation check page that includes your 
printer’s ROM version information, the ink counter code, and a 
nozzle check pattern. Below are sample printouts.

Good sample

Print head needs to be cleaned

The above sample is in black and white, but the actual test prints in color 
(CMYK).

If the nozzle check page does not print satisfactorily (for example, 
if any segment of the printed lines is missing), there is a problem 
with the printer. This could be a clogged ink nozzle or a 
misaligned print head. See the next section for details on cleaning 
the print head. For information on aligning the print head, see 
“Aligning the Print Head” on page 9-10.

Cleaning the Print Head

If you find that the printed image is unexpectedly faint or that 
dots in the printed image are missing, you may be able to solve 
these problems by cleaning the print head, which ensures that the 
nozzles are delivering ink properly.

Segments are missing
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You can clean the print head from your computer using the Head 
Cleaning utility in the printer software, or from the printer itself 
by using the printer’s control panel buttons.

Note:
❏ Print head cleaning uses both color and black ink. To avoid wasting 

ink, clean the print head only if print quality declines. For example, 
if the printout is blurry or the color is incorrect or missing.

❏ Use the Nozzle Check utility first to confirm that the print head 
needs to be cleaned. This saves ink.

❏ You cannot clean the print head while the B black or A color ink 
out light is flashing or on. Replace the appropriate ink cartridge first.

❏ Do not start the Head Cleaning or Nozzle Check utility while 
printing is in progress; otherwise, your printout may be marred.

Using the Head Cleaning utility

Refer to the appropriate section below to clean the print head 
using the Head Cleaning utility.

For Windows users
Follow the steps below to clean the print head.

1. Make sure that the printer is on and both the B black and A 
color ink out lights are off.

Note:
If the B black or A color ink out light is flashing, you cannot clean 
the print head. Replace the appropriate ink cartridge first.

2. Access the printer software. For directions, see “Accessing the 
printer software” on page 3-2.

3. Click the Utility tab, then click the Head Cleaning button.
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4. Follow the on-screen instructions.

The P power light flashes while the printer performs the 
cleaning cycle. This takes about one minute to complete.

c Caution:
Never turn off the printer while the P power light is flashing. 
Doing so may damage the printer.

5. When the P power light stops flashing, click Print nozzle 
check pattern in the Head Cleaning dialog box to confirm 
that the head is clean and to reset the cleaning cycle.

Below are nozzle check patterns:

Good sample

Print head needs to be cleaned

The above sample is in black and white, but the actual check pattern prints 
in color.

If you find that any segments are missing from the nozzle check 
pattern, you may need to repeat the head cleaning and print the 
pattern again.

Segments are missing
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If print quality hasn’t improved after repeating this procedure 
four or five times, turn the printer off and leave it alone overnight. 
Then, perform the head cleaning again.

If the print quality still has not improved, one or both of your ink 
cartridges may be old or damaged and may need to be replaced. 
To replace an ink cartridge before it is empty, see “Replacing an 
Old or Damaged Ink Cartridge” on page 8-8.

If print quality remains a problem after replacing the ink 
cartridges, contact your dealer.

Note:
To maintain print quality, EPSON recommends turning on the printer 
for at least one minute every month.

For Macintosh users
Follow the steps below to clean the print head.

1. Make sure that the printer is on, and the B black and A color 
ink out lights are off.

2. Click the  Utility icon button, then click the Head 
Cleaning button.

3. Follow the on-screen instructions.

The P power light flashes while the printer performs the 
cleaning cycle. This operation takes about one minute to 
complete.

c Caution:
Never turn off the printer while the P power light is flashing. 
Doing so may damage the printer.
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4. When the P power light stops flashing, click the 
Confirmation button in the Head Cleaning dialog box to 
print a nozzle check pattern and to reset the cleaning cycle. 
Use the check pattern to confirm that the print head is clean. 
See page 148 for a sample of the nozzle check pattern.

If print quality hasn’t improved after repeating this procedure 
four or five times, turn the printer off and leave it alone overnight. 
Then, perform the head cleaning again.

If the print quality still has not improved, one or both of the ink 
cartridges may be old or damaged and may need to be replaced. 
To replace an ink cartridge, see “Replacing an Old or Damaged 
Ink Cartridge” on page 8-8.

If print quality remains a problem after replacing the ink 
cartridges, contact your dealer.

Note:
To maintain print quality, EPSON recommends turning on the printer 
for at least one minute every month.

Using the control panel buttons

Follow the steps below to clean the print head using the printer’s 
control panel buttons.

1. Make sure that the P power light is on and that both the 
B black and A color ink out lights are off.

Note:
If the B black or A color ink out light is flashing or on, you cannot 
clean the head, and the operation described here will start the ink 
cartridge replacement procedure. If you inadvertently start the ink 
cartridge replacement procedure, press the R cleaning button to 
return the print head to its home position.
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2. Depress the R cleaning button for three seconds.

The printer starts cleaning the print head and the P power 
light begins flashing. Print head cleaning takes about one 
minute to complete.

c Caution:
Never turn off the printer while the P power light is flashing. 
Doing so may damage the printer.

3. When the P power light stops flashing, print a nozzle check 
pattern to confirm that the head is clean and to reset the 
cleaning cycle.

If print quality hasn’t improved after repeating this procedure 
four or five times, turn the printer off and leave it alone overnight. 
Then, perform the head cleaning again.

If the print quality still has not improved, one or both of your ink 
cartridges may be old or damaged and may need to be 
replaced.To replace an ink cartridge before it is empty, see 
“Replacing an Old or Damaged Ink Cartridge” on page 8-8.

If print quality remains a problem after replacing the ink 
cartridges, contact your dealer.
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Note:
To maintain print quality, EPSON recommends turning on the printer 
for at least one minute every month.

Aligning the Print Head

If you notice a misalignment of vertical lines, you may be able to 
solve this problem using the Print Head Alignment utility in your 
printer software. Follow the directions in the appropriate section 
below.

Note:
Do not start the Print Head Alignment utility while printing is in 
progress; otherwise, your printout may be marred.

For Windows users
Follow the steps below to align the print head.

1. Make sure that A4 or Letter size plain paper is loaded in the 
sheet feeder.

2. Access the printer software. For directions, see “Accessing the 
printer software” on page 3-2.

3. Click the Utility tab, then click the Print Head Alignment 
button.

4. Follow the on-screen instructions to align the print head.

For DOS users
Follow the steps below to align the print head.

1. Insert the printer software CD in your CD-ROM drive.
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2. Type D:\SETUP at the DOS prompt. (If your CD-ROM drive 
is assigned a drive letter other than "D", or if you are using the 
floppy disk version, substitute the appropriate letter.)

3. Press the Enter key, then follow the on-screen instructions.

4. After running the setup program, type C:\EPCALIB2. (If your 
hard drive is assigned a drive letter other than “C”, substitute 
the appropriate letter.)

5. Press the Enter key. The following window appears.

6. Make sure that your printer is selected. Click Next, then 
follow the on-screen instructions.

For Macintosh users
Follow the steps below to align the print head.

1. Make sure that A4 or Letter size plain paper is loaded in the 
sheet feeder.

2. Click the  Utility icon button, then click the Print Head 
Alignment button.

3. Follow the on-screen instructions to align the print head.
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Cleaning the Printer

To keep your printer operating at its best, clean it thoroughly 
several times a year as described below.

1. Make sure that the printer is turned off and that all of the 
printer’s lights are off. Then, unplug the power cord.

2. Remove any paper from the sheet feeder.

3. Use a soft brush to carefully clean away all dust and dirt from 
the sheet feeder.

4. If the outer case or the inside of the sheet feeder is dirty, clean 
it with a soft, clean cloth dampened with mild detergent. Keep 
the printer cover closed to prevent water from getting inside.

5. If the inside of the printer accidentally gets soiled with ink, 
wipe it off with a damp cloth.

w Warning:
Be careful not to touch the gears inside the printer.

c Caution:
❏ Never use alcohols or thinners to clean the printer; these 

chemicals can damage the components as well as the 
case.

❏ Be careful not to get water on the printer mechanism or 
electronic components.

❏ Do not use a hard or abrasive brush.

❏ Do not spray the inside of the printer with lubricants; 
unsuitable oils can damage the mechanism. Contact 
your dealer or a qualified service person if lubrication is 
needed.
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Transporting the Printer

If you need to transport your printer, carefully prepare and repack 
it using the original box (or a similar box that the printer fits 
snugly into) and packing materials. Follow the steps below.

1. Open the printer cover and make sure that the print head is 
in the home (far right) position. If it is not, turn on the printer 
and wait until the print head returns to the home position. 
Then, turn off the printer and close the printer cover.

c Caution:
Leave the ink cartridges installed when you transport the 
printer. Removing the cartridges during transport can 
damage the printer.

2. Unplug the power cord from the electrical outlet, then 
disconnect the interface cable from the printer.

3. Remove the paper from the sheet feeder, then remove the 
paper support.

4. Open the printer cover again. Secure the ink cartridge holder 
to the printer with tape as shown below, then close the printer 
cover.

5. Push in the output extension tray, then raise the output tray.

6. Attach the protective materials to both sides of the printer.
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7. Repack the printer and power cord in the original box.

8. Keep the printer level during transport.

Updating Software

Follow the directions in this section if you have upgraded your 
computer from Windows 95 to Windows 98 or if you are a 
Windows NT 4.0 or Windows 2000 user and wish to update your 
printer driver from a previous version. Refer to the appropriate 
section below.

Updating to Windows 98

If you have upgraded your computer’s operating system from 
Windows 95 to Windows 98, you must uninstall your printer 
software and then install it again. 

To uninstall the printer software, double-click the 
Add/Remove Programs icon in the Windows Control Panel and 
select EPSON Printer Software in the list. Click the 
Add/Remove button. The EPSON Printer Software Uninstall 
dialog box appears. Select the printer model, and then click OK. 
Then, install the printer software again.
9-14      Maintenance



Updating the driver in Windows 2000 or NT 4.0

When you update the printer driver in Windows 2000 or NT 4.0, 
please be sure to uninstall the previous printer driver before you 
install the new driver. Installing over the existing printer driver 
results in a failure to update. To uninstall the printer driver, 
double-click the Add/Remove Programs icon in the Windows 
Control Panel. The Add/Remove Programs Properties dialog box 
appears. Select EPSON Printer Software from the list, click 
Change/Remove (Windows 2000) or Add/Remove 
(Windows NT 4.0). The EPSON Printer Software Uninstall dialog 
box appears. Select the printer model and then click OK.
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Correcting USB Problems

Make sure that your computer is a Windows 98 
or Windows 2000 pre-installed model

Your computer must be a Windows 98 or Windows 2000 pre-
installed model. You may not be able to install or run the USB 
Printer Driver on a computer which is not equipped with a USB 
port or which has been upgraded from Windows 95 to Windows 
98 or 2000.

For details about your computer, contact your dealer.

Make sure that EPSON USB Printer Devices 
appears in the list on the Device Manager menu 
(for Windows 98 only)

If you canceled the plug-and-play driver installation before the 
procedure was completed, either the USB printer device driver or 
the printer driver may be installed incorrectly.
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Follow the steps below to check the installation and reinstall the 
drivers.

1. Turn the printer on. Plug the USB cable into the printer and 
the computer.

2. Right-click the My Computer icon on your desktop, then 
click Properties in the shortcut menu that appears.

3. Click the Device Manager tab.

If your drivers are correctly installed, EPSON USB Printer 
Devices should appear in the list on the Device Manager 
menu.

If EPSON USB Printer Devices does not appear in the list, click 
the plus (+) sign beside Other Devices to view the installed 
devices. 
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If USB Printer appears under Other Devices, the USB printer 
device driver is not installed correctly. If EPSON Stylus 
COLOR 980 appears, the printer driver is not installed 
correctly.

If neither USB Printer nor EPSON Stylus COLOR 980 appears 
under Other Devices, click Refresh or unplug the USB cable 
from the printer, then plug it into the printer again.

4. Under Other Devices, select USB Printer or EPSON Stylus 
COLOR 980, then click Remove. Then click OK.

5. When the following dialog box appears, click OK. Then click 
OK again to close the Properties window.

6. Turn off both the printer and the PC. Then, install the drivers 
again, following the instructions in the Setup Guide.
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Printer does not work correctly with a USB cable

If your printer does not work correctly with a USB cable, try one 
or more of these solutions:

❏ Use the recommended USB cable as described in “System 
Requirements” on page A-11.

❏ If you use a USB hub, connect the printer to the first tier of the 
hub, or connect the printer to the computer’s USB port 
directly.

❏ For Windows 98 users, try reinstalling the USB printer device 
driver and the printer software. First, uninstall EPSON Printer 
Software using the Add/Remove Programs utility in the 
Control Panel, then uninstall EPSON USB Printer Devices. 
Next, reinstall the software as described in Setup Guide. If 
EPSON USB Printer Devices is not registered in the 
Add/Remove Programs list, browse the CD-ROM and 
double-click epusbun.exe in the Win 9x folder. Then, follow 
the on-screen instructions.

Diagnosing the Problem

Troubleshooting printer problems is best handled in two easy 
steps: first diagnose the problem, then apply likely solutions until 
the problem is fixed. The information that you need to diagnose 
the most common problems is provided by the printer’s control 
panel lights and by the Status Monitor utility (for Macintosh and 
Windows 98, 95, 2000, and NT 4.0). You can also run a printer 
operation check to determine whether the problem originates 
with the printer or the computer. Refer to the appropriate section 
below.

Use the information presented in this chapter to pinpoint the 
source of your problem, then apply the recommended solutions 
until the problem is solved.
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Using the error indicators

You can identify many common printer problems using the lights 
on your printer’s control panel. If your printer stops working and 
the lights are on or flashing, use the following table of panel light 
patterns to diagnose the problem, then follow the recommended 
corrective measures.

Lights Problem and solutions

o S
Paper out

No paper is loaded in 
the sheet feeder.

Load paper in the sheet 
feeder, then press the E 
load/eject button. The printer 
resumes printing and the light 
goes out.

f S
n B
n A

Paper jam

Paper has jammed in 
the printer.

Press the E load/eject button 
to eject the jammed paper. If 
the error does not clear, open 
the printer cover and remove 
all of the paper inside, 
including any tone pieces. 
Then, reload the paper in the 
sheet feeder and press E 
load/eject button to resume 
printing.

f B
Ink low (black ink cartridge)

The black ink cartridge 
is nearly empty.

Obtain a replacement black 
ink cartridge (T003).

o B
Ink out (black ink cartridge)

The black ink cartridge 
is empty.

Replace the black ink 
cartridge with a new one 
(T003). See “Replacing an 
Empty Ink Cartridge” on page 
8-1 for details.

f A
Ink low (color ink cartridge)

The color ink cartridge 
is nearly empty.

Obtain a replacement color 
ink cartridge (T005).
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o = on, n = off, f = flashing

Using the Status Monitor (not available for 
Windows 3.1)

The Status Monitor utility provides status messages and a graphic 
display showing the current status of the printer.

If a problem occurs while printing, an error message is displayed 
in the Progress Meter window.

When the ink is out, click the How To button in the Status Monitor 
or Progress Meter window and EPSON Status Monitor will lead 
you step-by-step through the cartridge replacement procedure.

o A
Ink out (color ink cartridge)

The color ink cartridge 
is empty.

Replace the color ink 
cartridge with a new one 
(T005). See “Replacing an 
Empty Ink Cartridge” on page 
8-1 for details.

f P
f S
o B
o A

Carriage error

The print head is 
obstructed by jammed 
paper or other foreign 
material and cannot 
return to the home 
position.

Turn off the printer. Open the 
printer cover and remove any 
paper from the paper path by 
hand. Then, does turn the 
printer back on.

If the error does not clear, 
contact your dealer.

f P
f S
f B
f A

Unknown printer error

An unknown printer 
error has occurred.

Turn off the printer and 
contact your dealer.
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Running a printer operation check

Performing a printer operation check can help you to determine 
whether the problem comes from the printer or from the 
computer.

To print a printer operation check page, follow the steps below.

1. Make sure that both the printer and computer are turned off.

2. Disconnect the cable from the printer’s interface connector.

If you use the parallel interface, unlock the wire clips on both 
sides of the interface connector and remove the ground 
connector, if necessary. Then, disconnect the cable from the 
printer’s interface connector.

3. Make sure that A4 or Letter size paper is loaded in the sheet 
feeder.
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4. Hold down the E load/eject button and press the P power 
button to turn on the printer. Then, release both buttons.

The printer prints an operation check page, which includes the 
version of your printer’s ROM, the ink counter code, and a nozzle 
check pattern. 

Compare the quality of the printed check page with the sample 
shown below. If there are no print quality problems such as gaps 
or missing segments in the test lines, the printer itself is all right 
and the problem probably lies in the printer software settings or 
the application settings, or with the interface cable or the 
computer itself. Always use a shielded interface cable.

The above sample is in black and white, but the actual check page prints 
in color (CMYK).
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If the check page does not print satisfactorily as shown below, 
there is a problem with the printer. For example, if any segment 
of the printed lines is missing, the problem could be a clogged ink 
nozzle or a misaligned print head.

The above sample is in black and white, but the actual check pattern prints 
in color.

Cancelling Printing

If the printouts are not what you expect and display incorrect or 
garbled characters or images, you may need to cancel the print 
job. To cancel the print job, follow the instructions in the 
appropriate section below.

Segments are missing
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For Windows 98, 95, 2000, and NT 4.0 users

When you send a print job to the printer, the Progress Meter 
opens.

Click the Stop button to cancel the print job.

For Windows 3.1 users

When you send a print job to the printer, the Despooler opens.

Click the  Stop button to cancel the print job.
Troubleshooting      10-11



 

For Macintosh users

The procedure for canceling a print job from a Macintosh varies, 
depending on whether background printing is on or off. Refer to 
the appropriate section below.

When background printing is on
Follow the steps below to cancel the print job.

1. Press the P power button to turn off the printer.

2. Select EPSON Monitor3 from the application menu. EPSON 
Monitor3 opens.

3. Select the print job that you wish to cancel in the Document 
Name list, then click the  Stop icon button to cancel the print 
job.
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When background printing is off
Follow the steps below to cancel the print job.

1. Press the P power button to turn off the printer.

2. Hold down the J command key on your keyboard and press 
the period (.) key to cancel the print job.

Print Quality Could Be Better

If you are having print quality problems, try the solutions offered 
for the problems listed in this section.

Horizontal banding

Try one or more of these solutions:

❏ Make sure that the printable side of the paper is face up in the 
sheet feeder.

❏ Run the Head Cleaning utility to clear any clogged ink 
nozzles.

❏ Select Automatic as the Mode setting on your printer driver’s 
Main menu (Windows) or in the Print dialog box (Macintosh).

❏ Check the B black and A color ink out lights. If a light is 
flashing, replace the appropriate ink cartridge. See 
“Replacing an Empty Ink Cartridge” on page 8-1.

❏ Make sure that Maximum is not selected as the Printable Area 
setting in your printer driver. When this setting is selected, 
banding may occur in the expanded area.

❏ Make sure that the Media Type selected in the printer driver 
is appropriate for the type of media that is loaded in the 
printer.
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Vertical misalignment or banding

Try one or more of these solutions:

❏ Make sure that the printable side of the paper is face up in the 
sheet feeder.

❏ Run the Print Head Alignment utility.

❏ Clear the High Speed check box in your printer driver’s 
Advanced dialog box. For Windows users, see “Making 
Advanced settings” on page 3-13 for instructions. For 
Macintosh users, see “Making the Advanced settings” on 
page 5-10“.

❏ Run the Head Cleaning utility to clear any clogged ink 
nozzles. 

❏ Make sure that the Media Type setting selected in the printer 
driver is appropriate for the type of media that is loaded in 
the printer.

Color gaps

Try one or more of these solutions:

❏ Make sure that your paper is not damaged, dirty, or too old. 
Also, make sure that the printable side of the paper is face up 
in the sheet feeder.

❏ Run the Head Cleaning utility to clear any clogged ink 
nozzles. 

❏ Check the B black and A color ink out lights. If one of the 
lights is flashing, replace the appropriate ink cartridge. See 
“Replacing an Empty Ink Cartridge” on page 8-1.
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❏ Adjust the color settings in your application or your printer 
driver. For Windows users, see “Making Advanced settings” 
on page 3-13 for instructions. For Macintosh users, see 
“Making the Advanced settings” on page 5-10.

❏ Select Automatic as the Mode setting on your printer driver’s 
Main menu (Windows) or in the Print dialog box (Macintosh).

❏ Make sure that the Media Type setting selected in the printer 
driver is appropriate for the type of media that is loaded in 
the printer.

Colors are incorrect or missing

Try one or more of these solutions:

❏ Change the Ink setting in your printer driver to Color. For 
Windows users, see “Using the Automatic mode” on page 3-9 
for instructions. For Macintosh users, see “Using the 
Automatic mode” on page 5-7.

❏ Adjust the color settings in your application or your printer 
driver. For Windows users, see “Making Advanced settings” 
on page 3-13 for instructions. For Macintosh users, see 
“Making the Advanced settings” on page 5-10.

❏ Run the Head Cleaning utility. If colors are still incorrect or 
are missing, replace the color ink cartridge. If the problem 
persists, replace the black ink cartridge. See “Replacing an 
Empty Ink Cartridge” on page 8-1.

Blurry or smeared printout

Try one or more of these solutions:

❏ Make sure that your paper is dry and that the printable side 
is facing up. Also, make sure that you are using an acceptable 
paper type. See “Paper” on page A-2 for specifications.
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❏ Select Automatic as the Mode setting on your printer driver’s 
Main menu (Windows) or in the Print dialog box (Macintosh).

❏ If the paper is curled toward the printable side, flatten it or 
curl it slightly toward the opposite side. 

❏ Set the adjust lever to the “+” position, and make sure that the 
Media Type setting in your printer driver is correct.

❏ Remove each sheet from the output tray as it is printed, 
especially if you are using transparencies.

❏ If you are printing on glossy media or transparencies, place a 
support sheet (or a sheet of plain paper) beneath the stack. Or, 
load one sheet at a time.

❏ Run the Head Cleaning utility.

❏ Run the Print Head Alignment utility. 

❏ Ink may have leaked inside the printer. Wipe the inside of the 
printer with a soft, clean cloth.

w Warning:
Do not touch the gears inside the printer.

Wipe here
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Printouts Are Not What You Expected

If one of the following problems has occurred, try the solutions 
listed for that problem.

❏ Incorrect or garbled characters

❏ Incorrect margins

❏ Inverted image

❏ Blank pages print

❏ Printout has smears on the bottom edge

❏ Printing is too slow

Incorrect or garbled characters

Try one or more of these solutions:

❏ Select your printer as the default printer in Windows.

❏ Clear any stalled print jobs from the Spool Manager. For 
instructions, see “Using EPSON Spool Manager” on page 4-3.

❏ Turn off the printer and computer. Make sure that the 
printer’s interface cable is securely plugged in.

❏ If you are using NT 4.0, try to uninstall the EPSON Printer 
Port. Click Start and point to Programs, then point to EPSON 
Printers and click EPSON Printer Port Uninstall. Follow the 
on-screen instructions.

Incorrect margins

Try one or more of these solutions:
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❏ Check the margin settings in your application. Make sure that 
the margins are within the printable area of the page. See 
“Paper” on page A-2 for specifications.

❏ For Windows users, check the settings on the Paper menu. 
Make sure that the settings are appropriate for the paper size 
that you are using.

For Macintosh users, check the settings in the Page Setup 
dialog box. Make sure that the settings are appropriate for the 
paper size that you are using.

Inverted image

Clear the Flip Horizontal check box in the printer driver, or turn 
off the “Mirror” setting in your application. For instructions, see 
online help for the printer driver or for your application.

For Macintosh, see also “Making the Advanced settings” on page 
5-10.

Blank pages print

Try one or more of these solutions:

❏ Select your printer as the default printer in Windows.

❏ For Windows users, check the settings on the Paper menu. 
Make sure that they are appropriate for the paper size that 
you are using.

For Macintosh users, check the settings in the Page Setup 
dialog box. Make sure that they are appropriate for the paper 
size that you are using.

❏ Run the Head Cleaning utility to clear any clogged nozzles. 
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After trying one or more of these solutions, run a printer operation 
check to check your results. See “Running a printer operation 
check” on page 10-8 for details.

Printout has smears on the bottom edge

Try one or more of these solutions:

❏ If the paper is curled toward the printable side, flatten it or 
curl it slightly toward the opposite side.

❏ Set the adjust lever to the “+” position and clear the High 
Speed check box in your printer driver’s Advanced dialog 
box. The Advanced dialog box is accessible through the Main 
menu (Windows) or the Print dialog box (Macintosh) when 
Custom is selected as the Mode setting. To turn this option 
off, you may also need to change the Print Quality setting.

Printing is too slow

Try one or more of these solutions:

❏ Make sure that the Media Type setting in your printer driver 
is correct. For Windows users, see “Making the Media Type 
setting” on page 3-5 for instructions. For Macintosh users, see 
“Making the Media Type setting” on page 5-3.

❏ Select Automatic as the Mode setting on your printer driver’s 
Main menu (Windows) or in the Print dialog box (Macintosh) 
and then move the slider to Speed. For Windows users, see 
“Using the Automatic mode” on page 3-9 for instructions. For 
Macintosh, see “Using the Automatic mode” on page 5-7.

❏ Close any applications you are not using at the moment.
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Printer Doesn't Print

If one of the following error indications is displayed, try the 
solutions listed.

❏ All lights are off

❏ Lights came on and then went out

❏ Only the power light is on

❏ The S paper out light is flashing or on

❏ One of the ink out lights is flashing or on

❏ Ink out lights are on and the other lights are flashing

All lights are off

Try one or more of these solutions:

❏ Press the P power button and make sure that the printer is on.

❏ Turn off the printer and make sure that the power cord is 
securely plugged in.

❏ Make sure that your outlet works and that it is not controlled 
by a wall switch or a timer.

Lights came on and then went out

The printer’s voltage may not match the outlet rating. Turn off the 
printer and unplug it immediately. Then, check the printer label.

If the voltage does not match, DO NOT PLUG YOUR PRINTER 
BACK IN. Contact your dealer.
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Only the power light is on

Try one or more of these solutions:

❏ Turn off the printer and computer. Make sure that the 
printer’s interface cable is securely plugged in.

❏ Make sure that there is no packing material remaining inside 
the printer.

❏ Turn off the printer and computer and disconnect the 
printer’s interface cable. Then, print an operation check page. 
See “Running a printer operation check” on page 10-8.

If the check page prints, make sure that the printer software 
and your application are installed correctly.

❏ If you are trying to print a large image, your computer may 
not have enough memory to print. Try printing a smaller 
image.

❏ If you are using Windows 2000 or NT 4.0, try to uninstall the 
EPSON Printer Port. Click Start, point to Programs and 
EPSON Printers, then click EPSON Printer Port Uninstall. 
Follow the on-screen instructions.

❏ Clear any stalled print jobs from the Spool Manager. For 
instructions, see “Using EPSON Spool Manager” on page 4-3.

❏ If the printer sounds like it is trying to print but is unable to, 
run the Head Cleaning utility. 

If this does not work, replace the ink cartridges. See 
“Replacing an Empty Ink Cartridge” on page 8-1 for 
instructions.
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Paper out light is flashing or on

If the paper out light is flashing, remove any paper that may be 
jammed in the printer.

If the paper out light is on, load more paper in the sheet feeder.

One of the ink out lights is flashing or on

If the B black or A color ink out light is flashing, ink is low. 
Prepare a replacement cartridge.

If the B black or A color light is on, ink is out. Replace the 
appropriate cartridge. See “Replacing an Empty Ink Cartridge” 
on page 8-1.

Ink out lights are on and the other lights are 
flashing

Follow the steps below.

1. Press the E load/eject button, then remove any paper in the 
printer.

2. Turn the printer off. Check for and remove any foreign objects 
or pieces of paper from inside the printer. Also, make sure 
that there is sufficient space around the vent on the back of 
the printer to allow proper ventilation. Remove any objects 
that are blocking the vent. Then, turn the printer back on.

Note:
If you cannot remove a foreign object easily by yourself, do not use 
force and do not disassemble the printer. Call your dealer for 
assistance.

3. If the error is not cleared, contact your dealer.
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Paper Does Not Feed Correctly

If one of the following problems has occurred, try the solution(s) 
listed for the problem.

❏ Paper does not feed

❏ Multiple pages feed

❏ The paper jams

❏ Paper does not eject fully or is wrinkled

Paper does not feed

Remove the stack of paper and make sure of the following:

❏ The paper is not curled or creased.

❏ The paper is not too old. See the instructions that came with 
the paper for more information.

❏ The paper is not loaded above the arrow on the left edge 
guide.

❏ Paper is not jammed inside the printer. If it is, remove the 
jammed paper.

❏ The black and/or color ink cartridge is empty. Replace the 
appropriate cartridge. See “Replacing an Empty Ink 
Cartridge” on page 8-1.

Load the paper again. Make sure that you follow any special 
loading instructions that came with your paper. See also “Paper 
Handling” on page 19.
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Multiple pages feed

Remove the stack of paper and make sure that the paper is not too 
thin. See “Paper” on page A-2 for specifications. Fan the edges of 
the stack to separate the sheets, then reload the paper.

If too many copies of a document are being printed, check the 
Copies setting in both the printer driver and in your application. 
For Windows users, see “Modifying the printout style” on page 
3-21 for instructions. For Macintosh users, see “Modifying the 
Page Layout” on page 5-22.

The paper jams

Press the E load/eject button to eject the jammed paper. If the error 
does not clear, open the printer cover and remove all of the paper 
inside, including any torn pieces. Then, reload the paper in the 
sheet feeder and press E load/eject button to resume printing.

Note:
If you cannot remove a foreign object easily by yourself, do not use force 
and do not disassemble the printer. Call your dealer for assistance.

If your paper jams frequently, make sure of the following:

❏ The paper is smooth, not curled or wrinkled.

❏ The paper is of high-quality, loaded with the printable side 
up.

❏ The paper stack was fanned before loading.

❏ The paper is not loaded above the arrow on the left edge 
guide.

❏ The left edge guide is adjusted to fit your paper.
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Paper does not eject fully or is wrinkled

If the paper does not eject fully, press the E load/eject button. Also 
check the Paper Size setting in your application or printer driver.

If the paper is wrinkled when it comes out, it may be damp or too 
thin. Load a new stack.

Note:
Store any unused paper in its original packaging in a dry area. See 
“Paper” on page A-2 for specifications.

Paper dosen’t feed correctly when Using the 
double-sided printing feature

If multiple pages feed when using the double-sided printing 
feature, remove the paper as instructed in “Multiple pages feed” 
on page 10-24. You may be able to reuse the pages that were fed 
in error. Make sure that the paper is not wrinkled or creased, then 
reload it properly to ensure that no pages are skipped and that 
the document is printed correctly.

If paper jams when using the double-sided printing feature, 
remove the paper as instructed in “The paper jams” on page 10-24. 
If a number of print jobs have been sent to the printer, check the 
page settings in your application and confirm that the paper is 
loaded properly to ensure that no pages are skipped and that the 
document is printed correctly.

Where to Get Help

If your printer is not operating properly and you cannot solve the 
problem using the troubleshooting information in your printer 
documentation, contact customer support services for assistance.
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Customer support will be able to help you much more quickly if 
you provide them with the following information:

❏ Serial number of your printer
(the serial number label is on the back of the printer)

❏ Printer model

❏ Brand and model of your computer

❏ Printer software version
(click About in your printer driver)

❏ Windows version that you are using

❏ Software application(s) you normally use with your printer 
and their version number(s)

For United Kingdom and the Republic of Ireland users
If you purchased your product in the UK or the Republic of 
Ireland, EPSON (UK) LTD provides a range of customer services 
and technical support.

Support via the World Wide Web

❏ For information on the latest EPSON products, software 
drivers, on-line user guides and answers to frequently asked 
questions: 
http://www.epson.co.uk

❏ To email EPSON Technical Support: 
http://www.epson.co.uk/support/email/

❏ For a full list of EPSON Customer and Warranty Support 
services: 
http://www.epson.co.uk/support/
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Support via telephone

Our Customer and Warranty Support teams can be contacted by 
calling 0870 163 7766 in the UK or 0044 0870 163 7766 from the 
Republic of Ireland. They can provide the following services:

❏ Technical information on installing, configuring and 
operating your EPSON products

❏ Arranging for faulty EPSON products to be repaired within 
the warranty period

Pre Sales Enquiry Desk

Our Enquiry Desk team can be contacted by calling 0800 220546 
in the UK or 1 800 409132 from the Republic of Ireland, by faxing 
01442 227271 in the UK or 0044 1442 227271 from the Republic of 
Ireland, and via Email at info@epson.co.uk. They can provide the 
following information:

❏ Pre sales information and literature on new EPSON products 
(also available via our world wide web site at 
http://www.epson.co.uk)

❏ Where to purchase genuine EPSON consumables, 
accessories, and options

For Australia users
EPSON Australia wishes to provide you with a high level of 
customer service. In addition to this user’s guide, we provide the 
following sources for obtaining information:

EPSON FAXBACK

EPSON FAXBACK will fax you the latest specifications and 
pricing for most EPSON products offered in Australia. There is 
also technical information including details of the latest software 
and drivers available. Phone (02) 9903 9075 and the system will 
guide you through a number of choices before faxing the 
information to your fax machine.
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Internet URL http://www.epson.com.au

Access the EPSON Australia World Wide Web pages. Worth 
taking your modem here for the occasional surf! You can get the 
same information as offered on the EPSON FAXBACK and the 
EPSON Bulletin Board, plus more.

Your dealer

Don’t forget that your dealer can often help identify and resolve 
problems. The dealer should always be the first call for advice on 
problems. They can often solve problems quickly and easily as 
well as give you advice on the next step to take.

EPSON Helpdesk

EPSON Helpdesk is provided as a final backup to make sure that 
our clients have access to advice. Operators at the Helpdesk can 
aid you in diagnosing hardware and software problems. They can 
also advise you on the latest EPSON products and where the 
nearest dealer or service agent is located. Many types of queries 
are answered here.

The Helpdesk numbers are:

We encourage you to have all the relevant information on hand 
when you ring. The more information you prepare, the faster we 
can help solve the problem. This information includes the User’s 
Guide for your EPSON product, type of computer, operating 
system, application programs, and any other information you feel 
is required. 

For India users
Contacts for information, support and services are:

Phone: 1300 361 054

Fax: (02) 9903 9189
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World Wide Web (www.epson.co.in)

Information on product specifications, drivers for download, 
Frequently Asked Questions (FAQ) Product Enquiry and 
Technical Query are available.

Epson India Bangalore Head Office:

For Malaysia users
Contacts for information, support and services are:

World Wide Web (www.epson.com.my)

Information on product specifications, drivers for download, 
Frequently Asked Questions (FAQ) and Email Enquiry are 
available.

Epson Trading Shah Alam Head Office

For Singapore users
Sources of information, support and services available from 
Epson Singapore are:

World Wide Web (www.epson.com.sg)

Information on product specifications, drivers for download, 
Frequently Asked Questions (FAQ), Sales Enquiry, and Technical 
Email Support are available.

Phone: 080 5095465

Fax: 080 5095474

Phone: 03 5191366

Fax: 03 5191281
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Epson HelpDesk <Phone: (065) 5863111>

Our HelpDesk team can help you with the following over the 
phone:
Sales enquiry and product information
Product usage questions or problem
Enquiries on repair service and warranty

For Hong Kong users
To obtain technical support as well as other after-sales services, 
users are welcome to contact EPSON Hong Kong Limited. 

Internet home page

EPSON Hong Kong has established a local home page in both 
Chinese and English on the Internet to provide users with the 
following information:

❏ Product information

❏ Answers to Frequently Asked Questions (FAQs)

❏ Latest versions of EPSON printer drivers

Users can access our World Wide Web home page at: 
http://www.epson.com.hk

Electronic bulletin board system

An electronic bulletin board system (BBS) is also available to 
obtain printer information and the latest versions of printer 
drivers. You can log on to the following number for the BBS 
service:

BBS: (852) 2827-4244
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Technical Support Hotline

You can also contact our technical staff at the following telephone 
and fax numbers:

For Philippines users
To obtain technical support as well as other after sales services, 
users are welcome to contact the EPSON Philippines 
Representative Office at the telephone and fax numbers below:

Phone: (852) 2585-4399

Fax: (852) 2827-4383

Phone: (632) 813-6552

Fax: (632) 813-6545

BBS: (632) 814-0595
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Options

Interface cards

A number of optional interfaces are available to supplement the 
printer’s built-in interfaces. See “Using optional interface cards” 
on page 11-2 for more information.

If you are not sure whether you need an optional interface or if 
you want to know more about interfaces, contact your dealer.

Note:
The asterisk (✽) is a substitute for the last digit of the product number, 
which varies by location.

Ethernet Interface Card C82362✽
C82363✽
C82364✽
C82384✽

IEEE 1394 Interface Card C82372✽
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Using optional interface cards

Note the following when using optional interface cards:

❏ To use the Ethernet Interface Card 
(C82362✽/C82363✽/C82364✽/C82384✽) and IEEE1394 
Interface Card(C82372✽), see the documentation that comes 
with the card for setup information.

Follow these steps to install an optional interface card.

1. Make sure the printer is turned off and all the printer’s lights 
are off.

2. Unplug the power cord from the electrical outlet (and from 
the back of the printer, if your printer’s power cord is 
removable).

c Caution:
Do not install the interface card when the printer is 
connected to an electrical outlet. Doing so may damage the 
printer or your computer.

3. Turn the printer around so that its back faces you, and 
disconnect any existing interface cables.
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4. Use a cross-head screwdriver to remove the two screws 
securing the shield plate to the optional interface slot; then 
remove the plate. Be sure to keep both screws; you may need 
to use them again when you reinstall the shield plate.

5. Be sure to set any switches and jumpers on the card. See the 
interface card’s manual for details. If your interface card has 
a jumper labeled JG, make sure that you turn it on, or the card 
will not work properly.

6. Slide the interface card along the slots on both sides of the 
interface compartment. Push it in firmly to fully insert the 
connector at the rear of the interface card into the printer’s 
internal socket.
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7. Secure the interface card in the slot with the two screws 
included with the interface card.

8. Connect the proper interface cable to the interface card and to 
your computer. If the cable has a grounding wire, connect it 
to one of the screws securing the parallel interface.

Also, if you are using more than one computer, reconnect the 
other interface cable.

9. Make sure the printer is turned off. Then plug in the power 
cord.

Before you use the optional interface, you may need to change the 
setting for the interface option, such as I/F (interface) mode in the 
default-setting mode. If you need to change any settings, see  
“Changing the Print Settings” on page 12-2 for details.

To remove the interface card, follow the above steps in reverse 
order.

Consumable products

Ink cartridges
You can use the following cartridges with your printer.

Note:
The product numbers of ink cartridges may vary by location.

Media types
EPSON offers specially designed media for ink jet printers to meet 
most high-quality printing needs.

Black ink cartridge T003

Color ink cartridge T005
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EPSON Premium Ink Jet Plain Paper (A4) S041214

EPSON 360 dpi Ink Jet Paper (A4) S041059
S041025

EPSON 360 dpi Ink Jet Paper (Letter) S041060
S041028

EPSON Iron-On Cool Peel Transfer Paper (A4) S041154

EPSON Iron-On Cool Peel Transfer Paper (Letter) S041153
S041155

EPSON Photo Quality Ink Jet Paper (A4) S041061
S041026

EPSON Photo Quality Ink Jet Paper (Letter) S041062
S041029

EPSON Photo Quality Ink Jet Paper (Legal) S041067
S041048

EPSON Photo Quality Ink Jet Cards (A6) S041054

EPSON Photo Quality Ink Jet Cards (5 × 8”) S041121

EPSON Photo Quality Ink Jet Cards (8 × 10”) S041122

EPSON Photo Quality Self Adhesive Sheets (A4) S041106

EPSON Ink Jet Note Cards A6 (with envelopes) S041147

EPSON Ink Jet Greeting Cards 5 × 8” 
(with envelopes)

S041148

EPSON Ink Jet Greeting Cards 8 × 10” 
(with envelopes)

S041149
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EPSON Matte Paper-Heavyweight (A4) S041256
S041258
S041259

EPSON Matte Paper-Heavyweight (Letter) S041257

EPSON Photo Paper (A4) S041140

EPSON Photo Paper (Letter) S041141

EPSON Photo Paper (4 × 6”) S041134

EPSON Photo Paper (100 × 150 mm) S041255

EPSON Photo Paper (200 × 300 mm) S041254

EPSON Panoramic Photo Paper (210 × 594 mm) S041145

EPSON Photo Paper Cards (A4) S041177

EPSON Photo Quality Glossy Film (A4) S041071

EPSON Photo Quality Glossy Film (Letter) S041072

EPSON Photo Quality Glossy Film (A6) S041107

EPSON Photo Stickers 16 (A6) S041144

EPSON Photo Stickers 4 (A6) S041176
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Note:
The availability of special media varies by location.

EPSON Ink Jet Transparencies (A4) S041063

EPSON Ink Jet Transparencies (Letter) S041064

EPSON Premium Glossy Photo Paper (A4) S041287
S041297

EPSON Premium Glossy Photo Paper (Letter) S041286
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Installing the Printer Driver for DOS Programs

Most DOS software programs include a driver for EPSON 
ESC/P 2™ printers and require that you select the printer from a 
list to install the printer driver. To take advantage of your printer's 
advanced, built-in, scalable fonts and graphics handling, you 
must select an appropriate driver.

If your printer is not included in the list, contact your software 
manufacturer to obtain updated software.

If the manufacturer does not have an updated printer driver for 
your printer, select an alternative printer from those listed below, 
choosing the printers listed at the top first.

When printing in black only:

LQ-870/1170
LQ-570 (+)/1070(+)
SQ-870/1070
LQ-850
LQ-500

When printing in black and color:
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EPSON Stylus PRO
EPSON Stylus COLOR 500
EPSON Stylus COLOR II
LQ-860
LQ-2550

Note:
The drivers for the printers listed above do not allow access to all of the 
features offered by the EPSON STYLUS COLOR 980, such as 720-dpi 
printing, 1440-dpi printing, and MicroWeave.

DOS software varies greatly. See the printing section of your 
software manual for information on accessing the printer driver 
settings.

Changing the Print Settings

You can change many print settings such as print direction and 
loading position. Because these settings take effect each time you 
turn on the printer, they are also called default settings.

The factory default settings are designed to meet the needs of 
most users, so you may not need to change them. The table below 
lists the features you can select in the default-setting mode.

Settings Options

Font Courier, Roman, Sans Serif, Prestige, Script, 
Roman T, Sans Serif H, Draft

Pitch 10 cpi, 12 cpi, 15 cpi, 17.1 cpi, 20 cpi, 
Proportional

Print direction Auto, Bi-D, Uni-D

Loading position 8.5 mm, 3 mm, Others

I/F mode Auto, Parallel, USB

Auto I/F wait time 10 seconds, 30 seconds
12-2      Using the Printer Software for DOS



Note:
Most software controls the character table and auto line feed. If your 
software controls these features, you may never need to set them with 
the control panel.

Changing the default settings

To change the printer’s default settings, use the control panel 
buttons. Your selections are indicated by the control panel lights. 
Follow the steps below.

1. Make sure that the printer is turned off and that A4 or Letter 
size paper is loaded in the sheet feeder.

Network I/F mode Off, On

Parallel I/F transfer rate Fast, Normal

Software ESC/P 2, IBM X24E

Auto CR (IBM mode 
only)

Off, On

AGM (IBM mode only) Off, On

Auto line feed Off, On

0 slash 0, 0 with slash

Character table Standard model: Italic, PC437, PC850, 
PC860, PC861, PC863, PC865, BRASCII, 
Abicomp, Roman 8, ISO Latin 1, PC858, ISO 
8859-15

All other models: Italic, PC437, 
PC437 Greek, PC850, PC852, PC853, 
PC855, PC857, PC866, PC869, MAZOWIA, 
Code MJK, ISO 8859-7, ISO Latin 1T, 
Bulgaria, PC774, Estonia, ISO 8859-2, 
PC866 LAT, PC866 UKR, PCAPTEC, PC708, 
PC720, PCAR864, PC860, PC861, PC863, 
PC865, BRASCII, Abicomp, Roman 8, ISO 
Latin 1, PC858, ISO 8859-15
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2. Hold down the R cleaning button and turn on the printer 
to enter the default-setting mode.

The printer loads a sheet of paper and prints a brief summary 
and instructions. It instructs you to select the language that 
you want messages printed in (English, French, German, 
Italian, Spanish, or Portuguese).

3. Press the R cleaning button until the control panel lights 
indicate the language of your choice, as shown below.

o = On,  n = Off

4. Press the E load/eject button to print the current default 
settings and the next set of instructions in the language that 
you selected. The printed instructions include submenu 
tables that list all of the settings that you can change and 
describe the appearance of the control panel lights for each 
selection. Use these instructions to change the settings using 
the control panel.

5. After making your changes, exit the default-settings mode by 
turning off the printer.

Note:
You may exit the default-settings mode at any time by turning off the 
printer. Any settings that you have made remain in effect until you 
change them.

Language S B A
English n n o

French n o n

German n o o

Italian o n n

Spanish o n o

Portuguese o o n
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If you want to check the current default settings, enter the default-
settings mode again and print the current default settings. The 
current settings are indicated with arrows.
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Printing

Paper

Note:
Since the quality of any particular brand or type of paper may be changed 
by the manufacturer at any time, EPSON cannot attest to the quality of 
any non-EPSON brand or type of paper. Always test samples of paper 
stock before purchasing large quantities or printing large jobs.

Printing method On-demand ink jet

Nozzle configuration Monochrome (black) 192 nozzles
Color (cyan, magenta, yellow) 288 nozzles
(96 [each color] × 3)

Resolution Maximum 2880 dpi × 720 dpi

Print direction Bidirectional with logic seeking

Control code ESC/P2 and Raster graphics code
EPSON Remote
IBM X24E emulation code

Input buffer 256 KB

Character tables 1 italic and 12 graphics character tables
(33 graphics character tables are available 
in certain countries.)

Character sets 14 international character sets and 1 legal 
character set
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Paper specifications

Single sheets:

Envelopes:

Index Cards:

Size A4 (210 mm × 297 mm)
A5 (148 mm × 210 mm)
B5 (182 mm × 257 mm)
Letter (216 mm × 279 mm)
Half letter (139.7 mm × 215.9 mm)
Legal (216 mm × 356 mm) 
Executive (184.2 mm × 266.7 mm)

Paper types Plain paper, bond paper, special papers 
distributed by EPSON

Thickness
(for plain bond 
paper)

0.08 mm to 0.11 mm (0.003 to 0.004 inch)

Weight
(for plain bond 
paper)

64 g/m² (17 lb) to 90 g/m² (24 lb)

Size No. 10 (104.8 mm × 241 mm) 
DL (110 mm × 220 mm) 
C6 (114 mm × 162 mm) 
132 mm × 220 mm

Paper types Plain paper, bond paper, air mail

Thickness 0.16 mm to 0.52 mm (0.006 to 0.02 inch)

Weight 45 g/m² (12 lb) to 75 g/m² (20 lb)

Size A6 (105 mm × 148 mm)
5 × 8” (127 mm × 203 mm)
8 × 10” (203 mm × 254 mm)

Paper types Special papers distributed by EPSON
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Transparencies, Glossy Film:

Self Adhesive Sheets:

Matte Paper-Heavyweight:

Premium Glossy Photo Paper:

Photo Paper:

Size A4 (210 mm × 297 mm)
Letter (216 mm × 279 mm)
A6 (105 mm × 148 mm) [for glossy film]

Paper types Special papers distributed by EPSON

Size A4 (210 mm × 297 mm)

Paper types Special papers distributed by EPSON

Size A4 (210 mm × 297 mm)
Letter (216 mm × 279 mm)

Paper types Special papers distributed by EPSON

Size A4 (210 mm × 297 mm)
Letter (216 mm × 279 mm)

Paper types Special papers distributed by EPSON

Size A4 (210 mm × 297 mm)
Letter (216 mm × 279 mm)
100 mm × 150 mm
4 × 6" (101.6 mm × 152.4 mm)
200 mm × 300 mm
113.6 mm × 175.4 mm
Panoramic: 210 mm × 594 mm

Paper types Special papers distributed by EPSON
A-4      Printer Specifications



Photo Stickers:

Note:
❏ Poor quality paper may reduce print quality and cause paper jams 

or other problems. If you encounter such problems, switch to a higher 
grade of paper.

❏ Do not load curled or folded paper.

❏ Use paper under normal conditions:
Temperature 15 to 25°C (59 to 77°F)
Humidity 40 to 60% RH

❏ EPSON Photo Quality Glossy Film and Self Adhesive Sheets should 
be stored under the following conditions:
Temperature 15 to 30°C (59 to 86°F)
Humidity 20 to 60% RH

Printable area

Refer to the appropriate section below for the printable area of a 
particular media type.

Single sheets (including panoramic size) and index cards

Size A6 (105 mm × 148 mm) with 4 or 
16 frames

Paper types Special paper distributed by EPSON

A

B-L B-R

C
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Envelopes

A: The minimum top margin is 3.0 mm (0.12").

When loading multiple sheets of EPSON Photo 
Quality Glossy Film, the minimum top margin is 
30.0 mm (1.2").

B-L: The minimum left margin is 3.0 mm (0.12").

B-R: The minimum right margin is 3.0 mm (0.12").
(The minimum right margin may vary, depending 
on the media type.)

C: The minimum bottom margin is 14.0 mm (0.55").

✽: You can decrease the minimum bottom margin to 
3 mm by selecting Maximum as the Printable Area 
setting on the printer driver's Paper menu 
(Windows) or in the Page Setup dialog box 
(Macintosh). However, the minimum bottom 
margin varies, depending on the paper. Also, print 
quality may decline in the expanded area. Before 
printing large jobs using this setting, print a single 
sheet to confirm printout quality.

A

B-L B-R

C
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Ink Cartridges

Black ink cartridges (T003)

Color Black

Print capacity* 1200 pages (A4, ISO/IEC 10561 Letter 
pattern 360 dpi)

Cartridge life 2 years from production date
(within 6 months after opening package, at 
25°C [77°F])

Temperature Storage: -20 to 40°C (-4 to 104°F)
1 month at 40°C (104°F)
Transit: -30 to 60°C (-22 to 140°F)
1 month at 40°C (104°F)
120 hours at 60°C (140°F)
Freezing:** -16°C (3.2°F)

Dimensions 28.9 mm (W) × 67.4 mm (D) × 41.8 mm (H)
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Color ink cartridge (T005)

* The print capacity may vary, depending on how often you use the print head 
cleaning function and how often you use the printer.

** Ink thaws and is usable after approximately 3 hours at 25°C (77°F).

c Caution:
❏ EPSON recommends the use of original EPSON ink 

cartridges only. Other products not manufactured by 
EPSON may cause damage to your printer not covered by 
EPSON's warranties.

❏ Do not use an ink cartridge if the date on the package has 
expired.

Colors Cyan, magenta, and yellow

Print capacity* 570 pages (A4, 360 dpi, 5% duty each color)

Cartridge life 2 years from production date
(within 6 months of opening the package at 
25°C [77°F])

Temperature Storage: -20 to 40°C (-4 to 104°F) 
1 month at 40°C (104°F)
Transit: -30 to 60°C (-22 to 140°F) 
1 month at 40°C (104°F)
120 hours at 60°C (140°F) 
Freezing:** -18°C (-0.4°F)

Dimensions 54.0 mm (W) × 67.4 mm (D) × 41.8 mm (H)
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Mechanical

Electrical

Paper feed method Friction

Paper path Sheet feeder, rear entry

Sheet feeder capacity About 100 sheets of 64 g/m² (17 lb) paper

Dimensions Storage
Width: 467 mm (18.4 inches) 
Depth: 296 mm (11.7 inches) 
Height: 199 mm (7.8 inches)
Printing
Width: 467 mm (18.4 inches) 
Depth: 594 mm (23.4 inches)
Height: 325 mm (12.8 inches)

Weight 8.4 kg (18.5 lb) without the ink cartridges 
installed

120 V Model 220-240 V Model

Input voltage range 99 to 132 V 198 to 264 V

Rated frequency 
range

50 to 60 Hz

Input frequency range 49.5 to 60.5 Hz

Rated current 0.7 A 0.4 A

Power consumption Approx. 30 W (ISO/IEC 10561 Letter Pattern)
Energy Star compliant
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Note:
Check the label on the back of the printer for the voltage of your printer.

Environmental

* Stored in shipping container

** Without condensation

Safety Approvals

Safety standards:

Temperature Operation: 10 to 35°C (50 to 95°F)
Storage: -20 to 60°C (-4 to 140°F)
1 month at 40°C (104°F)
Transit:* -20 to 60°C (-4 to 140°F)
120 hours at 60°C (140°F)

Humidity Operation:** 20 to 80% RH
Storage:*,** 5 to 85% RH

U.S. model UL 1950
CSA C22.2 No.950

European model Directive 73/23/EEC
EN60950
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EMC:

System Requirements

For Windows computers

To use this printer, you need Microsoft® Windows® 98, 
Windows® 95, Windows® 3.1, Windows® 2000 or Windows 
NT® 4.0 installed and a shielded, twisted-pair parallel cable 
connected. If you wish to connect your printer to a USB port, you 
need a Windows 98 or 2000 pre-installed PC that is equipped with 
a USB port and is connected to the printer via a shielded USB 
cable.

Your computer should also meet the following system 
requirements.

U.S. model FCC part 15 subpart B class B
CSA C108.8 class B

European model Directive 89/336 /EEC
EN 55022 (CISPR Pub. 22) class B 
EN 50082-1

IEC 60801-2
IEC 60801-3
IEC 60801-4

EN 61000-3-2
EN 61000-3-3

Australian model AS/NZS 3548 class B

Minimum System Requirements Recommended System

i386/25 MHz for Windows 3.1

i486/25 MHz for Windows 95 and 
NT 4.0

i486/66 MHz for Windows 98 and 2000

Pentium or better processor
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Your computer dealer can help you update your system if it does 
not meet these requirements.

For Macintosh computers

To connect this printer to an Apple® Macintosh® computer, you 
must use a USB cable.

Your Macintosh must also meet the following system 
requirements.

Note:
❏ The amount of available memory varies according to the number and 

kind of applications that are open. To see how much memory is 
available, click About This Computer on the Apple menu and refer 
to the memory size (listed in kilobytes) under “Largest Unused Block” 
(1,024K=1 MB).

16 MB RAM 32 MB RAM or more for 
Windows 98, 95, and 3.1

64 MB RAM or more for 
Windows 2000 and NT 4.0

20 MB hard disk space for Windows  
98, 95, and 3.1

40 MB for Windows 2000 and NT 4.0

50 MB or more hard disk 
space for Windows 98, 95, 
and 3.1

100 MB or more for 
Windows 2000 and NT 4.0

VGA monitor VGA monitor or better 

Minimum System Requirements Recommended System

Mac OS 8.1

(If using the optional IEEE1394 
Interface Card, MacOS 8.6.)

Mac OS 8.5.1 or later

(If using the optional IEEE1394 
Interface Card, MacOS 8.6 or 
later.)

9 MB RAM

9 MB RAM when background 
printing is turned on.

21 MB RAM or more.

36 MB RAM or more when 
background printing is turned on.
A-12      Printer Specifications



❏ The memory requirements above are for printing on Letter size 
paper. These requirements may vary depending on the size of the 
paper, the type of application that you are using, and the complexity 
of the document that you want to print.

In addition to these system and memory requirements, you need 
10 MB of free hard disk space to install the printer software. To 
print, you also need extra hard disk space amounting to about 
twice the size of the file that you want to print.
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Glossary

The following definitions apply specifically to printers.

application
A software program that helps you carry out a particular task such as word 
processing or financial planning.

ASCII
American Standard Code for Information Interchange. A standardized coding 
system for assigning numerical codes to letters and symbols.

banding
The horizontal lines that sometimes appear when printing graphics. This occurs 
when the print head is misaligned. See also MicroWeave.

bit
A binary digit (0 or 1), which is the smallest unit of information used by a printer 
or computer.

brightness 
The lightness or darkness of an image.

buffer
The portion of the printer's memory used to store data before printing it.

byte
A unit of information consisting of eight bits.

characters per inch (cpi)
A measure of the size of text characters, sometimes referred to as pitch.

CMYK
Cyan (blue-green), magenta, yellow, and black. These colored inks are used to 
create the subtractive system array of printed colors.

color matching
A method of processing color data so that colors displayed on a computer screen 
closely match colors in printouts. A variety of color-matching software is 
available. See also ColorSync.

ColorSync
Macintosh software that is designed to help you get WYSIWIG (what you see is 
what you get) color output. This software prints colors as you see them on your 
screen.

cpi
See characters per inch.
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default
A value or setting that takes effect when the equipment is turned on, reset, or 
initialized.

DMA
Direct Memory Access. A data transfer feature that bypasses a computer’s CPU 
and allows direct communication between a computer and peripheral devices 
(like printers), and between one peripheral device and another.

dpi
Dots per inch. The dpi measures the resolution. See also resolution.

drive
A memory device, such as a CD-ROM drive, hard drive, or floppy disk drive. In 
Windows, a letter is assigned to each drive for easy management.

driver
A software program that sends instructions to a computer peripheral to tell it 
what to do. For example, your printer driver accepts print data from your word 
processor application and sends instructions to the printer on how to print this 
data.

economy printing
Printing in which images are printed using fewer dots to save ink.

error diffusion
Error diffusion blends individual colored dots with the colors of the surrounding 
dots to create the appearance of natural colors. By blending colored dots, the 
printer can achieve excellent colors and subtle color gradation. This method is 
best suited for printing documents that contain detailed graphics or photographic 
images.

ESC/P
Abbreviation for EPSON Standard Code for Printers, the system of commands 
that your computer uses to control your printer. It is a standard for all EPSON 
printers and is supported by most applications for personal computers.

ESC/P 2
An enhanced version of the ESC/P printer command language. Commands in 
this language produce laser-like features, such as scalable fonts and enhanced 
graphics printing.

Finest detail
This printer driver setting automatically makes your printouts sharper and 
clearer, especially when the printouts contain text. This may increase the time 
required for printing.

font
A style of type designated by a family name.
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grayscale 
A sequence of shades of gray from black to white. Grayscale is used to represent 
colors when printing with black ink only.

halftones 
Patterns of black or colored dots used to reproduce an image.

halftoning
A method of using dot patterns to represent an image. Halftoning makes it 
possible to produce varying shades of gray using only black dots, or a nearly 
infinite array of colors using only a few colors of dots. See also halftones.

high speed printing
Printing in which images are printed in both directions. This results in faster 
printing.

initialization
Returns the printer to its defaults (fixed set of conditions). This happens every 
time you turn on the printer or reset the printer.

ink cartridge
Contains the ink that your printer uses when printing.

ink jet
A method of printing in which each letter or symbol is formed by precisely 
spraying ink onto the paper.

interface
The connection between the computer and the printer. A parallel interface 
transmits data one character or code at a time. A serial interface transmits data 
one bit at a time. 

interface cable
The cable that connects the computer and the printer.

local printer
The printer that is directly connected to the computer’s port by an interface cable.

media
Materials upon which data is printed, such as envelopes, plain paper, special 
paper, and transparency film.

memory
The part of the printer’s electronic system that is used to store information (data). 
Some of the information is fixed and is used to control how the printer operates. 
Information that is sent to the printer from the computer is temporarily stored in 
memory. See also RAM and ROM.

MicroWeave
Printing in which images are printed in finer increments to reduce the possibility 
of banding and to produce laser-like images. See also banding.
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monochrome
Printing using only one color of ink, which is generally black.

nozzle
Fine tubes in the print head through which ink is sprayed on the page. Print 
quality may decline if the print head nozzles are clogged.

operation check
A method for checking the operation of the printer. When you perform a printer 
operation check, the printer prints the ROM version, code page, ink counter code, 
and a nozzle check pattern.

parallel interface
See interface.

port
An interface channel through which data is transmitted between devices.

printable area
The area of a page on which the printer can print. It is smaller than the physical 
size of the page due to margins.

printer driver
A software program that sends commands for using the features of a particular 
printer. See also driver.

print queue
When your printer is connected to a network, a waiting line in which print jobs 
that are sent to the printer are held while the printer is busy.

RAM
Random Access Memory. The portion of the printer's memory that is used as a 
buffer and for storing user-defined characters. All data that is stored in RAM is 
lost when the printer is turned off.

reset
To return a printer to its defaults by turning the printer off and then back on.

resolution
The number of dots per inch used to represent an image.

ROM
Read Only Memory. A portion of memory that can only be read and cannot be 
used for data storage. Data that is stored in ROM is retained when you turn off 
the printer.

RGB
Red, green, and blue. These colors, in phosphors irradiated by a cathode ray tube 
(CRT) monitor's electron gun, are used to create the additive array of screen 
colors.
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serial interface
See interface.

spool
The first step in printing, in which the printer driver converts the print data into 
codes that your printer understands. This data is then sent directly to the printer 
or to the print server.

spool manager
The software program that converts print data into codes that your printer 
understands. See also spool.

sRGB
The color management method used to maintain color consistency between 
devices which adhere to the sRGB standard.

Status Monitor
The software program that allows you to check the printer’s status.

subtractive colors
Colors produced by pigments that absorb some colors of light and reflect others. 
See also CMYK.

USB interface
Universal Serial Bus interface. Enables the user to connect up to 127 peripheral 
devices (such as keyboards, mice, and printers) to the computer through a single, 
general-purpose port. The use of USB hubs allows you to add additional ports. 
See also interface.

WYSIWYG
What-you-see-is-what-you-get. This term is used to describe printout that looks 
exactly like it appears on screen.
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